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Introduction

ParagorMigration Suitet for Serveroffersall facilitiesthat may require in hardware upgrade worigrationof Windows
Server With its help a system administratoan:

1

Upgrade storagen Windows Server (any version since SeAd0) Use ouradvancedcopy wizards to

accomplish this type adperation with minimal efforts.

Migrate WindowsServer(any vergon since Server 20000 a different hardware platformWhen upgrading to

newer or pst replacing failed hardware use our uniqgue P2P technology to guarantee startup of your system or
dissimilar hardware configuration.

TransfetWindowsServer (any version since Server 2@00 virtual @avironmentof one of the supported
virtualization software vendor@P2V).

Migration Suite for Servaromes with a comprehensive bootable environment based on WIinPE 3.0 that enables to
accomplish any operation without the software installati®ipporting a widerange of hardware configurationshas
the option to add drivers for specific hardware-tive-fly.

The product supports ditest hardware including AFD (Advance Format Dravedl other non512B sector size disks,
HDD drives of more than 2TB inesas well as USB 3.0 devices

In this manual you will find the answers to many of the technical questions, which might arise while using the prograr

A

Our company is constantly releasing new versions and updates to its software, that's wt
images shown in this manual may be different from what you see on your screen.

7EAO0B8 O MidkationBiite

1

Theupdated P2V Cop\Restore Wizard$o migrate a WindowsJK & a A OF f ae@aidSy of A @S
backup) to a virtual environment of one of the supported virtualization software vendors. In the Vatsahn
of the product the wizards enable to:

- Create and properly configure virtual machines according to your preferences. Depending on the selected
GANIdzZl £t ATIFGA2Y @SYR2NJ e2dzQ@S 320G G(KS 2LIA2y (2
f20F0A2y> wl!a (2 tft20FrGS2 I RA&]l O2yGNRffSNE
only a virtual disk that contains an operating system and/or data, but a reEadge virtual machine.

- Convert any combination of hard disks gattitions to migrate your entire computer or certain partitions
in one operation. Complex backups that contain partitions from different hard disks are supported as well.

- Employ MS VSS (Volume Shadow Copy Service) to synchronously migrate from saVdisk$iathus
ensuring data consistency during online migration of a system, which seats on several partitions or hard
disks. This is achieved by taking a pairtime snapshot of the whole disk subsystem.

- When migrating from several hard disks, alltieik 3y I G dzZNBa Attt o6S (1SLIN Ayl
letters in a virtual environment.

The updated P2V Adjust OS Wizalibws creation of virtual machines as well, so besides its primary function,
you can now build virtual machines out of supported virtual disks or Windows Vista/7 backup images.

/ 2 L& N 3 RG16 Paradodg Software Group. All rights reserved.



6

1 Create VD Wizartb create an empty virtual disk or with specific data of one of the supported virtualization
vendors.

9 The updated P2P Adjust OS Wizdodsuccessfully start up a WindowBysical system on a different hardware
platform (P2P) by allowing injection of all required drivers and the other actions crucial for thisftype
migration. Including the third generation Barago® a ! RIF LJGA @S wS&a0i2NBun (SOKy?2

- Analyze all installed drivers inside a target system to report on devices without drivers.
- Search for and install lacking drivers from the builtWindowsrepository.

- Notify the user about boot critical devices without drivers (HDD/RAID controllers, etc.), automatically
prompting to provide a path to a driver repository.

- Name all devices according to their model description, not some alphanumeric codl, retjigres
additional deciphering.

- Determine and install drivers not only for boot critical devices, but for physically connected NICs as well.
1 Automatic partition alignmentduring partitioning/copy operationto optimize performance of your hard disk.

1 Check FS Integrity and Data Loss Politielet you specify the acceptable balance between the operation
performance and the risk of data loss.

1 Conversion of basic MBR disks tagic GPTo enjoy all benefits of the newest partitioning scheme with
minimal effort.

1 WinPE 3.0 based bootable environmettt enjoy support of a wider range of hardware configurations with the
option to add divers for specific hardware etme-fly.

1 Better support for64-bit platformsto rebootyour computer to one of the threspecial mode (Windows
native, Linux, or DOS) to automatically complaperatiors, whichcannot be accomplished under &t
Windows.

1 AFD (Advanced Format Drive) ready
9 Support of 2TB+ and neB12B sector size drives
1 USB 3.0 ready

Product Components
In order to cope with different tasks, the product contains several components:

1 Windows based sebf utilities is the crucial part of the product. With the help of an easy to use launcher you
may find and run tasks of any complexity in the field of data and system protection, hard disk partitioning and
cloning, etc.

1 WinPE basedecovery environment Especially for keen followers of Windows, our product also offers a WinPE
3.0based botable media. Unlikéhe Linux/DOS recovery environmeihtan boast an excellent hardware
support and he same interfacasthe Windows versiortan However its system requirements are much
tougher.

Features Overview
This chapter dwells upon key benefits and technical highlights of the product.
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Features

Let us list some of thieatures:

User Friendly Fault Minimizing Interface
1 Grgohical representation of the datdo gain a better understanding.

A handyLauncherto easily find and run the required tasks.

1

1 Comprehensive wizardw simplify even the most complex operations.
1 A context sensitive hinsystemfor all functions of the program.
1

Previewing the resulting layout of hard disks before actually executing operati(swscalled virtual
operations).

Backup Facilities

1 Available location forbackup images

- Backup to local mountegiartitions.

- Backup to an external mounted storatgeprovide for a higher level of data protectiamd system
independence

- Backup to a network drivt® stand a better chance of succésscase of a hard disk failure.

Restore Facilities
1 Restore an entire diskseparate partitionsor only files you needrom the previously created backup image.

1 Restore with Shrinko restore a backup image to a free block of smaller size taking into acoalynthe
amount of actual data of the image.

9 Adaptive Restordo successfully migrate a Windoyhysical system to a different hardware platform (P2P) by
allowing automatic injection of all required drivensdathe other actions crucial for a migration of this kind.

A This featureis only available for the bootable recovery environment.

Copy Facilities

1 Partition/ hard disk copyto successfully transfer all edfisk information including standard bootstrap code and
other system service structures, thus maintaining the operating 3y§t&d ¢ 2 NJ Ay 3 OF LI 0 A f A

A Copy functionality can also be used as an alternative way of data protection.

Virtualization Facilities
1 P2V Copyo migrate a Windowghysical system to a virtual environment in the online mode.

1 P2V Restoréo migrate a Windowghysical system backed up with a Paragon desasicovery tool to a virtual
environment.

1 P2V Adjusto recover the startup ability after unsuccessful virtualization with a 3rd party tool.
/ 2 L& N 3 RG16 Paradodg Software Group. All rights reserved.
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8

Create VDo create an emptyirtual disk or with specific data of one of the supported virtualization vendors.

A Virtualization is the latest trend in the system migration, protdéon, and evaluation.

Partition/Hard Disk Management Facilities

1

Basic functions for initializing, partitioning and formatting hard diskseate, format, delete). Instead of the
standard Windows disk td®, the program supports all popular file systems.

Mount a partition (assign a drive letter) of any file system type to make it available for your operating system.

Modify file system parametergmake active/inactive, hide/unhide, etc.).

Undelete Partitions Wizardo recover an accidentally deleted partition.

Auxiliary Facilities

1

Con\ersion of basic MBR disks to basic GBEnjoy all benefits of the newest partitioning scheme with
minimal effort.

File Transfer Wizartb make such operations as transferring of files/directories or burnirterh to CD/DVD
as easy and convenient as possible. Providing acc&magorbackups as regular folders, it may also help to
replace corrupted data from a previously created image in case of an operating system failure.

Volume Exploreis a handy tool when you have different file systems on the disk, whether they contain an
operating system or just data. Volume Explorer will let you explore a file system of any type and provide acce:
to the necessary files and directes regardless of their security attributes.

Network Configuration Wizardo establish a network connectiaon a bootable recovery medigither to save a
backup of a partition/hard disk or just several files ame#vork computer or retrieve a previously made backup
from a network computer for recovery purposes.

Boot Correctorto fix most of the system boot problems that can be a result of a human factor, program error ot
a boot virus activity.

A Boot Corrector is only available for the bootable recovery environment.

Supported Technologies

Along with using innovativeethnologies from outsidéaragorhas developed a number of its own original
technologies that make its products unique and attractive for customers:

1

Paragonl 2 (i . | t€chndtbdy to back up locked partitions and hard disks under Windows NT+ family
operating systems providing both high operating efficiency as well as low hardware requirements.

Paragon Hot Copy technology to copyocked partitions and hard sks under Windows NT+ family operating
systems providing both high operating efficiency as well as low hardware requirements.

Paragon R LJi A @S teehBolody2odliBcassfully migrate a Windowhysical system to a different
hardware platform (P2P)

/ 2 L& N 3 RG16 Paradodg Software Group. All rights reserved.
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Pamgont 2 ¢ S NJ {tekhn&adgyRatprovide data consistency in case of a hardware malfunction, power
outages or an operating system failure.

ParagonUFSDx technology to browse partitions of any file system including hidden and unmounted, modify
and copy fils and folders, etc.

Paragorw S & G 2 NB ¢ kechRology KoNdstgrd atbackup image to a free block of smaller size taking into
account only the amount of actual data of the image.

Paragon{ Y I NIi t ltendihdlogyitc@sgcurely perform hard disk paditing operations of any complexity.

ParagonBTE« technologyto settasks for execution during th&ystem restart, thus saving from the need to use
a bootable media Wwen modifying system partitions

Microsoft Volume Shadow Copy Servi¢éSS) to provide theopy/backup infrastructure for the Microsoft
Windows XP/Vista/7/Server 2003/2008 operating systems. It offers a reliable mechanism to create consistent
point-in-time copies of data known as shadow copies. Developed by Microsoft in close cooperationewith th
leading copy/backup solution vendors on the market, it is based on a snapshot technology concept.

Microsoft Dynamic Disksimple, spanned, striped, mirrored, RAPto offer more management flexibility
without the patrtition limitation of basic disks. Bgmic storage can be particularly beneficial for lasgale
businesses when dealing with many physical hard disks involving complex setup.

GUID Partition Tabl¢GPT). It is the next generation of a hard disk partitioning scheme developed to lift
restrictions of the old MBR. GPT disks are now supported by Windows Vista/7, Server 2008, Mac OS X and L

Supported Virtual Machines

)l
)l
)l
1
)l
1

T

Microsoft Virtual PC
Microsoft Virtual Server
Microsoft HyperV
VMware Workstation
VMware Fusion
VMware ESX Server

Oracle VirtuédBox

Additionally for P2V Adjust O8nly

1

MS Windows backups (.vhd images)

Supported File Systems

)l
)l

Full read/write access to FAT16/FAT32 partitions.

Full read/write access to NTFS (Basic Disks) under Windows, Linux and PTS DOS. Compressed NTFS files ¢
supported.

Full read/write access to Ext2FS/ExtBE@®&IF Jartitions.

Limited read/write access to Apple HFS+ partitions.

A

Unfortunately, support of mn-Roman characters for the HFS+ file system is unavailable
the moment. The company is about to implement it in the nearest future.
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Supported Media
1 Support of both MBR and GPT hard digk&TB+ disks includgd
IDE, SCSI and SATA hard disks
SSDg{olidState Drivég
AFD (Advanced Format Drive)
Non512B sector size drives
CDR, CERW, DVER, DVD+R, DMRW, DVD+RW, DVR) DVD+R double layer and alsoBludiscs
FireWire (i.e. IEEE1304)JSB 1.0, USB 210SB 3.0ard disks

= =4 =4 =4 =4 =4 =4

PC card storage devices (MBRI &PT flash memory, etc.)

Getting Started

In this chapter you will find all the information necessary to get the product ready to use.

Distribution
ParagorMigration Suitds distributed in two ways:
1 Boxedpackage from Paragon SoftwaBanbH and resellers

z

T D2gyt2FIRFO0ES LI O1F3AS 20SNJ dskeS LYUSNYySaG a4 GKS 02y

Distributive CD

The boxed package includes a distributive CD that is irafaobtable recovery environmemtith auto-run of the
Windows installation, thus it can be used as areadde solii A 2y ® . dzi A F @2 dzQNBE 3I2Ay 3
you need to install them first (sdastallatior).

If you want to download an update/upgrade of the product, it will be in form of the downloadable installatidageac
as described i@nline Distributio.

Online Distribution

Migration Suitepurchased over the Internet will be in form of an MSI package.

Registration

Paragon Softwar&mbH provides a wide range of online seegi through its welportal - www.paragon
software.com/support!

1 Registration of new users;
1 Registration of purchased products for registered users;

1 Available aroundhe-clock downloading center, wherregistered users can get product updates/upgrades as
well as all the necessary documentation;

1 Downloadable free demo versions and open documentation for all users.

A It is recommended to use Internet Explorer 5+ or any compatible browser.

/ 2 L& N 3 RG16 Paradodg Software Group. All rights reserved.
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To register as a new user

To register as a new user, please do the following:

1. Run an Internet browser and visit the pagevw.paragonsoftware.com/myaccount
2. ClickCreateof the Create a Paragon Accouséction;
3. Fill out a registration form;
4. ClickRegister
The most important field in the form is annBail address, as it serves as a login to etite system. Besides your access
password will be sent to this address as well.
To register a new product
If you are a registered user and would like to regisfiégration Suite please do the following:

Run an Internet browser and visit the pagevw.paragonsoftware.com/myaccount/

In the Emailfield of theAuthorization section, enter an #ail used for registration;
In the Passwordield enter a password received after registration

ClickSign in

If the user name and password are valid, you will get to your account;

ClickRegister new producof the Productssection;

N o o s~ w Db

Enter your product serial number in tt&erial Numbeffield. You can find it in the product box or obtain from
yourreseller. CliciNext,

8. On the next page you will be asked to provide some additional data. Also you will need to decide whether you
want to get confirmation on registering the product byrail or not. CliciNext, and then cliclinish

That is all. The pduct is now registered.

How to Download Updates/Upgrades
Downloading of updates/upgrades can be fulfilled in the following way:

1. Run an Internet browser and visit the pagevw.paragonsoftware.com/my-accountt

In the Emailfield of theAuthorization section, enter an #ail used for registration;
In the Passwordield enter a password received after registration;

ClickSign in

If the user name and password are valid, you will get ta ymgount;

SelectMy Downloadsof the Productssection to see what updates are available for you;

N o o b~ w DN

Select the desired update and clidbwnload

Contacting Paragon Software GmbH

If you have any questions about the company products, please do not teeiteontact Paragon Softwa@mbH.

Service Contact

Visit Paragon Softwaraveb site www.paragonsoftware.com

Registration & updates welservice www.paragonsoftware.com/support
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Knowledge Base & Technical Support kb.paragomrsoftware.com

Pre-sale information sales@paragosoftware.com

System Requirements

For the Windows installation package

T

=A =4 =4 =4 =4 =4 =4

Operating systems:
- Windows XP (32 and 64 bit)

- Windows Server 20032 and 64 bit)
- Windows Vista (32 and 64 bit)

- WindowsServer2008 (32 and 64 bit)
- Windows 7 (32 and 64 bit)

- WindowsServer2008R2 64 bitonly)

Internet Explorer 5.0 or higher

Intel Pentium CPU or its equivalent, with 300 MHz processor clock speed
128 MB of RAM256+ recommended)

Hard disk drive with 25MB of available space

SVGA video adapter and monitor

Keyboard

Mouse

A During the installation additional free space (up to 1GB) will be required.

For the WIinPE bootable environment

)l
1
)l
|l
)l

Intel Pentium Il CPU or its equivalent, with 1000 MHz praceadsck speed
At least 512 MB of RAM

SVGA video adapter and monitor

Keyboard

Mouse

Additional requirements

|l
)l
)l

Network card to send/retrieve data to/from a network computer
Recordable CD/DVD drive to burn data to compact discs

ExternalUSB hard drive to ste data.
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Installation
To installParagorMigration Suite please do the following:

1. Run Setup ApplicatiorClick on the *MSiI file. This application will guide you through the process of the
program installation. The setup utility is compiled with the IiiStaield SDK, hence it contains the standard user
interface and set of installation steps.

In case there is some previous version of the program ifishon the computer, the
program will offer the user to uninstall it first.

2. Starting SetupThe Welcome page informs that the application is being installed. Click the Next button to
continue.

3. Confirm License Agreementhe License Agreement page diggléheParagoriicense Agreement. Read the
agreement and then select the appropriate option to accept. If you do not agree with any conditions stated
there, the installation process will be interrupted. By clicking the Print button, the License Agreemgaisa
be printed out.

4. Provide Registration InformationOn the Registration page you are to provide your product key and serial
number.

5. Provide Customer InformationOn the Customer Information page you are to provide the standard
information, i.e. a usename and an organization. Besides you need to decide whether to make the program
available for all users of this computer (if several) or only for the current one.

6. Select an Installation FoldeiThe Destination Folder page allows you to choose a foldherevthe program will
be installed. By default, the installation folder will be created as:

C\Program FilesParagonParagonMigration Suitep ¢ 2 &St SOG | y2 i KS Nittdhz2 £ RS NE

After you have selected the required folder, click the Nextdouto continue.

Do not install the program on network drives. Do not use Terminal Server sessions to in
and run the program. In both cases, th@ogram functionality will be limited.

7. Confirm Installation On the Ready to Install the Program page click the Install button to start the installation or
the Back button to return to any of the previous pages and modify the installation settings.

8. Copyng FilesThe Copying Files page shows the overall progress of the installation. Click the Cancel button to
abort the setup.

9. Finishing the InstallationThe Final page reports the end of the setup process. Click the Finish button to
complete the wizard.

mode hotcore driver, thus the system reboot is required to cptate the installation

: To accomplish online operation on locked partitions/hard disks the program uses a kern
procedure.
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First Start

To startParagorMigration Suiteunder Windows, please click the Windows Start button and then sBlegrams >
ParagonMigration Suitetx  FmragonMigration Suitex.

The program provides wide opportunities in the field of hard disk structure modification,
A just to be on the safe side, please make a backup of your data before carrying out any
operation.

The first component that will be displayed is called the Express Launcher. Thanks to a well-tutugitégorization
and hint system, it provides quick and easy access to wizards and utilities that we consider worth using on a regular
basis. Withitshe L] @2dz OFl'y | fa2 adl NI dzLJ 6KS GNIRAGAZ2YLEFE I dzy

@ Paragon Migration Suite for Server }F"
Paragon Migration Suite .
~ fearacon

for Server

", Copya Copy & Migration

Migration

‘ Copy Hard Disk
Virtualization Upgrade your hard drive by creating an exact copy from one 1o ancther hard drve. Please note #
there is any content on the target disk & will be overwritten

» Copy Partition

BaCRuP & Make a copy of a patition

Restore

T =

Tools

)

e,

Support
Contacts

¢

& Open Advanced Interface

Q t2 1y26 Y2NB 2y K2g¢g G2 KIYyRfS GKS LINERd

please consult thelVindows Componentghapter.

Booting from the WinPE Recovery Media

The WInPE recoveryneironment can be a real alternative to the Linux/DOS recovery environment. Providing nearly th
same level of functionality it offers an excellent hardware support and the same intexfdlce Windows version does.
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Startup
To start working with the WinPcovery environment, please take the following steps:

1. Start up the computer from our WinPE recovery media.

To automatically boot from the recovery edia please make sure the dnoard BIOS is set
up to boot from CD/USB first.

2. Onceit has been loaded, you will see the License Agreement. Read the agreement and then mark the
appropriate checkbox to accept. If you do not agree with any conditions staged, youv2 y QG 0SS | o f
the program.

Press Page Up and Page Down to scroll the text

End User License Agreement __:-l
between

PARAGON Software GmbH,
Heinrich-von-Stephan-Str. 5 ¢, 79100 Freiburg, Germany,

and

You, as end user

If you accept the terms of the agreement, click the check box below

v [L\,agcept the terms in the License Agreement |

Accept Decline I

3. Once you accept the agreement, you will see the Universal Application Launcher. In general it enables to run
components of the product, load devs for undefined hardware or establish a network connection.
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() Paragon Migration Suite™ for Server _g_LQJ}J

Paragon Mlgratlon Suite™

[(Ai .\)”’\

Copy & C()py & Migl’ation

Z. Migration

#) Copy Hard Disk

\

|
ol : S 1N Upgrade your hard deve by creating an exact copy from one to ancther hard drive. Please note #
ﬁ';;- Virtualization 1 there is any content on the target disk @ wil be overwritten

‘ Copy Partition
': Backup& Make a copy of a partition
F: Restore

EHE Tools

0
Contacts

& Full Scale Launcher B Restart [8) Shutdown

4. Click on the required operation to start. Hints on the selected at the moment iterheldlyou make the right
choice.

5. Consult the help system by pressiigT+F1o know more on the subject.

Our WInPE 3.0 based recovery environment offers excellent hardware supponveyer in
A OrasS Al R2SayQi KIFI@S I RNAGSNI F2NJ &2 dzNJ
Please consult thé\dding specific driverscenario to know how to tackle this issue.

Basic Concepts

Thischapter explains terms and ideas that show how the program works. To understand these helps to obtain a gene
notion of the operation performance and makes it easier for the user to operate the program.

System and Data Protection

The data protection ®ue is a growing cause of worrying for more and more people today. Indeed, it is hardly to find a
person who will be particularly happy when all precious information on the hard disk is irreversible lost as a result of i
malfunction. So how this tragedyan be prevented?

Backup Storage

Ourprogram supports severdl SOKyY A lj dzSa 2F aG2NAy3 o6 O1dzld AYF3Saod [ S
what kind of storage is able to provide better security:
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1 You can place a backup image to a local partitidespite the fact that it is the most convenient way, try not to
use it. You can delete your backup just by accident or lose it as a result of a hardware malfunction, or a virus
attack;

1 You can place a backup image to an external mounted storage to pririd higher level of data protection
and system independence

1 You can place a backup image to a network drive to stand a better chance of success in case of a hard disk
failure. Moreover, by storing it on a specfalrpose server you may be pretty surethingwill happen to it

Adaptive Restore

Technology Background

Windows family operating systems are notorious for their excessive sensibility to hardware, especially when it turns t
replacement of such a crucial device as HDD controller or motherlwpactiially Windows will most likely fail to boot
as a result of this operation.

In 2008 our company came with an exclusive technology cBedgon R LJG A @S wSald2NBud LyA
Windows Vista or Server 2008 from a backup to a different hardware configuration, its current realization, available ir
the P2P Adjust OS Wizard, enables to makgWindowsOS since XBootable on dissimar hardware by allowing
automatic injection of all required drivers and the other actions crucial for this type of migration.

Technology Concept
[ SGQa GF 1S | ParagpradapideReswre wdrkd. K 2 &

Source environment

k

Maodifying OS

Adi kernel
internal settings djusting kerne

k.

Drivers for PS)
Devices

Modifying additional
settings

Reselting CP
parameters

ki

Injecting drivers for
# boot critical devices
and NICs

From additional
driver repositornes

From the Windows
Repositony

k.

Destination
Environment

As you seesuccessful migration of a Windowgstem to a different hardware platform involves several actions:

1. Change of the Windows kernel settings according to the new configuratibime program detects the given
hardware profile ad automatically installs the appropriate Windows HAL and kernel.
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2. Installation of drivers for boot critical devicesThe program detects those without drivers and automatically
tries to install lacking drivers from the bulity’ 2 A Yy R2 g & NI &8 driveil i tNéraposliofy, it K S NF
prompts the user to set a path to an additional driver repository, strongly recommending not to proceed until &
drivers for the found boot critical devices are installed. In case drivers for these devices are instlled,
disabled, they will be enabled.

3. Installation of drivers for a PS/2 mouse and keyboaithis action will onlydaccomplished for Windows
XP/Server 2003.

4. |Installation of drivers for network cardsThe program detects those without drivers and automdkjciies to
install lacking drivers fromthe buiky 2 Ay R2 g4 NBLR aAAG2NE® LT GKSNBQa
user to set a path to an additional driver repository.

These adbns guarantee a Windowsy/stem will start up on dissimilar dware. After the startup, Windows will initiate
NEO2YFAIdANI A2y 2F Fff tfdaAdydtflre RSOAOSad LGQaA | 2
at this step to get the most out of the system.

Though all Windowsystems have builn driver repositories, please be prepared to have
A additional driverswhen dealing with WindowsXP/Server 2003, because for these system:
they are very modest.

Technology Application

[ SG1Qad O2yaARSNI I ydzYoSNI 2F &aAddz GAz2ya 6KSy (GKS ! RI LI
1 If you need to migrate to a different hardware platform with minimal effort
9 If you need to upgrade hardware while keeping all programs and settings intact

1 If you need to replace failed hardware and cannot find an exact match for original system specifications

Known Issues

1. After transferring Microsoft Vista and later versions to different hardware, you will need-aotreate license of
0KS aeé aii Sarbehatiod a3 thesy ¥/Stiis keep tracking any change of hardwaaetiRation is legally
justified in this case, as you transfer your system to another PC.

2.LF &2dzQ@S AyailultfSR aSOSNIft 2LISNI GAy3 aestyvdrshivgt 2y
OS. Microsoft highly recommends that you install an operating system on a separate partition.
3.tftSHasS y24S RNAGSNB INBE y20 OF OKSR Rd2NAy3I &St SOl
AGQa | f NBI Re Hizgdergtior the poofran witl @éridEhg” aperation with an error.
System Virtualization

2A0K yS¢6 LRSSNFdzZ Eyc O2YLMzi SNBI &2adGSY GANIdzZ € AT F GA
enables to run several virtual machines on one plafsitachine, providing resources of that single computer are shared
across several environments. As a result one and the same physical computer can have multiple OSs and applicatiol
operating simultaneously, thus opening up enormous opportunities for Hmikiness and home users, exactly:

1 Avoid underutilization of upo-date powerful computers;
1 Increase flexibility of a physical infrastructure;

9 Provide for increased availability of hardware and applications;
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9 Cut expenses on hardware and energy;

1 Guarantee sooth and cost saving system migration;

T 9ya22e g2NJlAy3 6AGK 2fR | LILX AOFGA2ya &2dz OFyQd €I
i Take advantage of having multiple operating systems on one Windows PC, including Linux, Mac OS X, etc.;
1 Forget about hunting for replacement6fK S FIF Af SR KI NRgI NBZ FyR YlIyeé Y2

Known Issues
1. You should install integration services (e.g. VMware Tools) on the virtual system yourself. We only guarantee

smooth startup.

2. Atfter transferring Microsoft Vista and later versions to a virtual disk,wiltneed to reactivate license of the
aeaidsSyo LGQa y2NX¥If o0SKF@AZ2NI I & GKSa-&ctvatdraisiegaig 1 S
justified in this case, as you transfer your system to another PC.

3. If your system hosts several Windowse®Sour program will find them all and automatically patch to run in a
virtual environment. However we cannot guarantee smooth startup of all found Windows systems, but the
guest OS, for its configuration parameters may be incompatible with the others.

Dynamic Disks

As you probably know, MBOS, Microsoft Windows 95/98/Me/NT/2000/XP/Vista/Server 2003/2008 support four
primary partitions per physical hard disk, one of which can be extended. Certainly there is the possibility to create
logical drives withinhe extended partition. Such types of disks are called basic. Windows XP Professional, Windows
2000, Windows Vista and Windows Server 2003/2008 follow the same strategy: You can have a maximum of four
primary partitions, one of which can be an extended ftiem with logical drives. However, these operating systems also
introduce a new disk configuration typelynamic disk which must be understood to effectively configure and manage
hard disks.

Dynamic disk is a physical disk that doesn't use partitioriggical drives. Instead, it contains only dynamic volumes.
Regardless of what format you use for the file system, only Win2K computers can access dynamic volumes directly.
However, computers that aren't running Win2K can access the dynamic volumes hgmben connected to the

shared folders over the network.

Dynamic disks can axist on a system with basic disks. The only limitation is that you cannot mix Basic and Dynamic
disks on the same hard drive.

There are five types of dynamic volumes: simpke@ifree space from a single disk), spanned (created from free disk
space that is linked together from multiple disks), striped (a volume the data of which is interleaved across two or mo
physical disks), mirrored (a fatitilerant volume the data of wih is duplicated on two physical disks, and RAID
volumes (a faultolerant volume the data of which is striped across an array of three or more disks).

With dynamic storage, you can perform disk and volume management without the need to restart Windows.
Limitations:

1 Dynamic disks are not supported on portable computers.
1 Dynamic disks are not supported on Windows XP Home Edliisad computers.

1 You cannot create mirrored volumes or RAIBolumes on Windows XP Home Edition, Windows XP
Professional, or Wolows XP 68it Editionbased computers.
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Thus, the dynamic disk is a new way of looking at hard disk configuration. Dynamic disks offer you more managemer
flexibility without the partition limitation of basic disks. Dynamic disks can contain an unlimiteter of volumes, but
they cannot contain partitions or logical drives. Dynamic storage can be particularly beneficial feadaleybusinesses
when dealing with many physical hard disks involving complex setup.

GPT versus MBR

GUID Partition Table (GH3Yhe next generation of a hard disk partitioning scheme developed to lift restrictions of the
old MBR. Being a part of the Extensible Firmware Interface (EFI) standard proposed by Intel to replace the outdated
BIOS, it offers a number of crucial beitgef

1 Up to 128 primary partitions for the Windows implementation (only 4 in MBR);

1 The maximum allowed partition size is 18 exabytes (only 2 terabytes in MBR);

1 More reliable thanks to replication and cyclic redundancy check (CRC) protection of the ptabten
T

A well defined and fully seilflentifying partition format (data critical to the platform operation is located in
partitions, but not in urpartitioned or hidden sectors as this is the case with MBR)

64-bit Support

The bulk of software today is wten for a 32bit processor. It can meet the requirements of almost any end user.
However that is not the case when dealing with servers processing large amounts of data with complex calculations «
very large numbers. That is where-b#t architecture cones into play.

It can boast improved scalability for business applications that enables to support more customer databases and moi
simultaneous users on each server. Besides-hitidernel can access more system resources, such as memory
allocation per ser. A 64bit processor can handle over 4 billion times more memory addresses thaibia [@cessor.

With these resources, even a very large database can be cached in memory.

Although many business applications run without problems ohiB2ystems, diers have grown so complex that they
use up the 4 GB memory limitation of a-BR address space. With this large amount of data, fewer memory resources
are available to meet memory needs. On alfidserver, most queries are able to perform in the buffavailable to the
database.

Some 32bit applications make the transition to the @4t environment seamlessly others do not. For instance, system
level utilities and programs that provide direct hardware access are likely to fail. Our program offerfteddelt
support of the 64bit architecture providing faultolerant work for such system dependent modules as Hot Processing.

Copy Operations

Hard drive duplication nowadays is becoming highly popular among PC users. That is due to some definite adivantag
can offer. First of all, many people clone hard disks just to back up data for security reasons. The present day copy
utilities enable to successfully transfer all-disk information including standard bootstrap code and other system
servicestructub & > G Kdza YFAYyGlFrAyAy3d GKS 2LISNIGAy3 aeadsSvyqQa ¢:
can get the system back on track in minutes. No additional configuration is required, what is very convenient.

The second possible application is thgrade of a hard disk to a new one. The capacity of a modern hard drive double:
every two years, thus opening up new possibilities for software developers. As a result programs become more
complicated and require considerable amount of free space. On¢hg#ayser realizes that there is no more free space
left on the hard disk and the only way out is to upgrade. Usually that means that besides purchasing a new hard disk
the user is to face a large-iestallation procedure spanning several days of tediwosk. But all of this can be avoided

just by copying the contents of the old hard disk to a new one proportionally resizing the partitions.
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And the last but not least is the copying of hard disks for cloning purposes. It may be of great use whengsetting u
similar computers. There is no need for a system administrator to install an operating system from scratch on every c
of them. It is enough just to configure one and then clone it to the others.

Drive Partitioning

As you probably know a hard drive @slie split into one or more partitions, since it cannot hold data until it is carved up
and space is set aside for an operating system. Until recently most PCs used to have just one partition, which filled tt
entire hard disk and contained an OS. Theaditun has changed however, thanks to new eeffective high capacity

hard drives, thus opening up numerous possibilities for PC users, such as editing video, archiving music, backing up
images, etc. Huge increase in space is great, but it poses a nafp@blems, most important of which are effective

data organization and speed.

Large drives are always going to take longer to search than smaller volumes, and an operating system is going to ha
work cut out both finding and organizing files.dffor this reason that many people decide to invest in multiple hard
drives, but there is an easy solutiqrrive partitioning. Partitioning lets you divide a single physical drive into a number
of logical drives, each of which servers as a containeritgittwn drive letter and volume label, thus enabling the
operating system to process data more efficiently. Besides partitioning makes it possible to organize data so that it is
easy to find and manage. You can set aside, for instance, 40 GB of a 18l @Bve for the OS, 70 GB for storing

video and another 50 GB for your favorite music collections to provide transparent data storage.

It is also worth mentioning to that with a hard drive properly partitioned, such routine operations as files de
fragmertation or consistency check will not be that annoying and tznasuming any more.

By detaching the OS from the rest of the data you can tackle one more cruciat isscase of a system malfunction,
you can get the system back on track in minutes bpvedng it from a backup image located on the other partition of
the hard drive.

But that is not all drive partitioning may be used for. If you are willing to play games in Windows while browsing the
Internet in Linux, 10@ercent sure that no virus wilkack your PC, drive partitioning is a necessity. In order to run
several OSs on a single hard drive you are to create a corresponding number of partitions to effectively delineate the
boundaries of each OS.

Windows Components

In the given section you cdimd all the information necessary to successfully work with the Windows version of the
product.

Interface Overview

This chapter introduces the graphical interface of the program. The design of the interface precludes any mistake bei
made on the part ofhe user. Most operations are performed through the system of wizards. Buttons and menus are
accompanied by easy understandable icons. Nevertheless, any problems that might occur while managing the progr:
can be tackled by reading this very chapter.

General Layout

When you start the program, the first component that is displayed is called the Launcher. It enables to run wizards ar
dialogs, to specify program settings, to visualize the operating environment and the hard disk configuration.

¢ KS [ I dzirddw &NER Zonditionally subdivided into several sections that differ in their purpose and
functionality:
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Main Menu j=2 o8
Tools Changes Wizards Hard Disk Partition View Help =
‘ (@\
&%Qﬁ)@ @H @\x \@@

Disk View | Help

e D |

Virtualization Virtual
Operations Bar

@) raveoy
Volume letter: C) Serial mumber: ADF4-BASD-FABA-7S5E
0% #2vRestore Volume tabel: [0 label] Partition ID: (07 NTFS o
Type: Prmay NTFS version: 301 !
@ v g ] Fle system: NTFS Volume size: 159G8
3 Root entries: 16 Partition size: 153G8
8-/ . Sectors per boot: § Used space: 13GB
\r Create Vitual Disk | Sectors per duster: 8 Free space: 25G8
3 Batbage: Yo
Common S : No
Tasks Bar
: Format Pastition =
g "ﬂ T T
4 ’

system:
£ Basic MBR Hard Disk 0 (VMware De Sdmurbod
d Disk Map Sectors per cluster: §
Local Disk (C:) - Serial number: AOF4-BASDF4

1 - " Partition 1D: 007 NTFS
== : NTFS version: 301 -
« »
W NTFS FATR2 W FATIE Umnx B42 Linux B43 pole HF
No changes.

1. Main Menu
2.Tool Bar

3. Virtual Operations Bar

4. Common Tasks Bar

5. Explorer Bar
6. Disk Map

7. Partition List
8. Properties Bar

9. Legend Bar
10. Status Bar

A number of panels offer similar functionality with a synchronizgdu& The program enables to conceal some of them
to simplify the interface management.

All panels are separated by vertical and horizontal expandable sliders, allowing the user to customize the screen layc

Main Menu
The Main Menu provides access to tatire functionality of the program. The available functions are as listed below:

MENU ITEM FUNCTIONALITY
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Tools

View Log Files

View logs on the carried out operations

Transfer data from any media

Settings... Edit the general settings of the program
Exit Exit the program
Changes

Undo “the last virtual
operation®

Cancel the last virtual operation on the List of FegdOperations

Redo ‘the last virtual
operation®

Cancel the last undo virtual operation on the List of Pending Operations

6EAx #EAT CAOS

Display the List of Pending Operations

Apply Changes

Launch the real execution of virtual operations

Discard All Changes

Cancel all virtual operations on the List of Pending Operations

Reload Disk Info

Refresh the current information about disks

Wizards

Create a partition of any file system

Format a partition of any file system

Delete a patrtition of any file system

51 AAT ACGA 0AOOH

Recover an acciderita deleted partition

3Ei DI A "AAEODS

Create a sectebased archive of an entire hard disk or separate partitions

Restore8

Restorean entire hard disk, separate paitihs, orfiles from the backup image

# OAAOA 6EOOOAI

Create an empty virtual disk or with specific data of one of the supported
virtualization vendors

P2V Copy8

Migrate a live Windowgphysicalsystem to a virtual environment

0c6 2AOO0T OAS

Migrate a Windowghysical system backed up with a Paragon disaster
recovey tool to a virtual environment

0c6 ! AEOOO [/ 3 8 Make Windows Vista/7 backups bootable on virtual hardwageover the
startup ability after unsuccessful virtualization with aggarty tool
#1 DU (AOA $ E OH Create a hat disk copy

#1 DU O0AOOEOET I

Create a partition copy

Hard Disk
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#1 1 OA0OO O1 " AQ

Convert a dynamic MBR disk containing simple volume(s) into a basic MB

Convert to Basic MBR hard
AEOES

Convert a basic or a dynamic GPT disk containing simple volume(s) into a
MBR disk

Convert to GPT hard disk

Convert a basic MBR disk intbasic GPT disk

Update MBR

Update MBR (Master Boot Record) of the selected hard disk

00I PAOOEAOS

Get indepth information on the properties of selected hard disk

Partition

Create a partition

&1 O AO 0 AOOE OHF Format a partition
$ AT AGA 0 A OOE OH Delete a partition
Il OOECT $OEOA | Assigndrive letter to the selected partition

2AT 1T OA $OEOA

Remove drive letter for the selected patrtition

Hide 0O AOOEOEIT T 8

Make the selected partition unavailable for the operating system

51

Make the selected partition available for the operating system

Mark Partition as Active

Make the selected partition bootable by default

Mark Partition as Inactive

Make the selected partition nchootable by default

Change Volume, AAAIT 8

Change volume label of the selected partition

Check File System
I OACOEOQOUS

Check the selected partition for possible file system errors

00i PAOOEAOS

Get indepth information on the properties of selected partition

View

Layouts Manage the Launcher layout with several predefined profiles

Toolbar Manage the Tool Bar representation: show / hide standard and navigation
buttons, text labels and large icons

Status Bar Display the Status Bar

Common Tasks Bar

Display the Common Tasks Bar

Disk Map Legend

Display the Disk Map legend

Properties and Commands

Display the Explorer Bar

Disk Map Location

Select whether the Disk Map will be located on the top of the maidaiv or
at the bottom
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Help
Help Open the Help system (you can also do it by pressing F1)
About Open the dialog with information about the program

c The Main Menu contents available at the moment may vary depending on the selected
object.

Tool Bar

The Toolbar provides fast access to the most frequently used operations:

BUTTON FUNCTIONALITY

‘Es Virtualize a hard disk or partition
|

‘Ej Copy a hard disk
|

f'a Copy a partition

@ Switch to Express launcher

@ Open the Help system

Virtual Operations Bar

The program supports previewing the resulting layout of hard disks before actually executing operaticalte(so
virtual mode of execution). In fact, when th&tual mode is enabled, the program does not accomplish operations
immediately, but places them on the List of Pending Operations for later execution.

The Virtual Operations Bar enables to manage pending operations.

BUTTON FUNCTIONALITY

l&j Cancel the last virtual operation on the List of Pending Operatior
@ Cancel the last undo virtual operation on the List of Pending
Operations

) Display the List of Pending Operations

Launch the real execution of virtual operations

% Cancel all virtual operati@on the List of Pending Operations
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Virtual mode is an effective way of protection from any troubles, since no operations will
be executed until cliking the Apply button for confirmation, thus giving a second chance
weigh all pros and cons of this or that particular operation. The program politely reminds
the user that there are unsaved changes by showing the following window:

A I There are unsaved changes. .

Please use the ¥ Apply command to comre the changes and the X Discard
command to permanently undo the changes

You can view the changes history via the . View Changes command and

temporarily undo of redo the oparation by means of the " Undo and " Redo
commands

Common Tasks Bar

The Common Tasks Bar is located on the left side of the main window. It is intended for easy access to the program*
wizards.

Thebar contains several tab&achab includesa sepaate button bar which can be folded by clicking it.

Virtualization Tasks

[,(_“‘?-I P2V Copy Starting the P2V Copy Wizard to migrate a Windows system to a virtual
‘ environment by converting all indtad software and data into a virtual machine

Starting the P2V Restore Wizard to restore a Windows physical system from

s
[,ﬁ- P2V Restore ) ) ]
backup directly to a virtual environment.

@ P2V Adiust Starting the P2V Adjust OS Wizard to restore functionality of a virtual
environment after unsuccessful virtualization withh@party tools; prepare
virtual machines out of supportedrtual disks or Windows .vhd backup images

Starting the Create Virtual DisKizard tocreate an empty virtual disk or with
specific data of one of the supported virtualizatieendors.

::..H Create Virual Disk

Copy Tasks

EC | Copy Hard Disk Starting the Copy Hard Disk Wizard to copy a hard disk.

= . i . i,
¢ Copy Partiion Starting theCopy Partition Wizard to copy a partition.

Backup Tasks

Starting the Sector Backup Wizard to create an archive of a hard disk or sepd

E‘.:T, Simple Backup o
partitions.

["‘j& Restore Starting the Restore Wizard to restore a hard disk, separate partition, or files
. the backup image.

Tools

Starting the File Transfer Wizard to transfer data from any media. Besides it
provides access tBaragorbackups as regular folders to browse through their

¥ Fie Transfer Wizard
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contents or copy required files.

@ Undelete Pariions Starting the Undelete Partitions Wizard to recover accidentally deleted partiti

Helpand Documentation

\? Migration Suite™ Help Launching the help system (you can also do itiegging F1).

Opening the page which contains information about the program. This page

'\_.fl About Migration Suite™ ) -
be displayed in the Explorer Bar.

Disk Map

The Disk Map is displayed in tB&plorer Bawhen the Disk View tab is selected. It is located either at the top or at the
bottom of the window, depending on the state of the Disk Map Location option (Main Menu: View > Disk Map
Location).

As the name infers, thei§k Map displays the layout of physical and logical disks. Physical disks are represented with
rectangle bars that contain smalized bars. These smalked bars represent logical disks. Their color depends on the
file system of the appropriate partition

-

Basic Hard Disk 0 (VMware. VMware Virtual S SCSI Disk Dev)
Local Disk (C:)
4399 GB NTFS
Largesized bars display the following information about physical disks:
1 Manufacturer,
1 Model.
Smallsized bars display the following information about logical disks:
9 Serial number,
9 Drive letter,
i Total size,
1 File system.
CdNI KSNY2NB>Z Al Aa LlRaaAraotsS G2 SadAyridsS GKS dz&aSR RAZ
2FTFSNA (2 OK22aS FTNRY &aSOSNIt GelLlSa 2F (KS osabdity. Fdrl & 2
AyaiulyOSz AF &2dz2Q@S 320 | KAIK OFLI OAGE KFENR RNAGS (
than 10 GB) partitions, you can select the logarithmic type to make all partitions readable, otherwise (selecting the
iy SFNJ GellSv &2dz 62y Qi o6S FofS (G2 &aSS avrftf LINIAGAZ2Y
layout is critical for you, the linear type is exactly what you need.

bSOSNIKSt Sdaa (KSNES Qlinealscaling WhltheEniviichal it ta Snfaltiparitiang. So if a partition is
too small it will remain readable.

Just click on the arrow icon on the top right side of the Disk Map to select the desired scaling type.
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I |

w Linear
Linear Scaling Min Width
Loganthmic Scaling
]

=

Lirnex Ext4 ReizerFS

Disk Map is synchronized with the Explorer Bar. Thus by selecting a disk on the Disk Map, the Explorer Bar will
automatically display detailed information on it.

The dragand-drop functionality is not available when the logarithmic type of the disk
layout is selected.

Explorer Bar

The Explorer Bar is located in the center of the main window which emphasizes its importance. The har displa
reference information including:

1 The help system
1 General information on the product including its name, w@nsand a list of helpful links
1 Detailed information about disks selected on thesk Map
1 Volume Explorer utility
According to these categories the Explorer Bar has several tabs:
9 Disk View which offers the user the following options:
- Partition Listo get a clearcut picture of the current state ohe system hard disks/partitits

- Volume Exploretio browse and export contents oé selected partition/hard disk

- Propertiego view detailed information on the selected partition/hardskliin thebright graphical form

E You can switch between these components by clicking tabs on the left side of the Explo
Bar.

9 Help, which contains the progm help and general information on the product.
You can access the desired information by clicking on the appropriate tab.

The Explorer Bar is a fuliynctional embedded HTML browser, which offers the possibility to address, for example, the
company's webite to look through important technical notes or download the latest updates without having to close
the program.

The program help is also HT¥tiented. You can read it and follow external links from to get additional information.

To easily navigate tbugh browsed pages, the program provides the following functionality:

BUTTON FUNCTIONALITY

Return to the previously browsed
page

PN
sy
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= Open the next browsed page

L )

o Stop loadig the current page

Refresh the contents of the current
page

Partition List

The Partition List is another helpful tool that enables yogeaba cleaicut picture of the current state of the system
hard disks/partitions. Partitions are sorted according to their starting position. For every item of the list there is the
possibility to call the contex¢ensitive popup menu with available opdrats. Besides, the program provides detailed
information on all hard disks/partitions found in the system including the following properties:

- Name,

- Volume label (if exists),

- Partition type (Primary/Extended /Logical),
- File system type,

- Size,

- Amount of used and unused (free) space,
- Start/End cylinder,

- Start/End head,

- Start/End sector

- Free size in sectors/bytes

- Active/Inactive attribute

- Hidden/Unhidden attribute

You may customize outlook of the P#an List by clicking on the arrow icon on the top right side of the panel.
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Please select properties to display.

Please select properdies you would Bke 1o display in the Disks and Partllions view

Hame
Size pectors)
F5 Size (sactons)

Usad [sactors)
Start (seciors)
Erid {sactors)

o] (o] =) [==) ] ] [ 2

Pattion D
Sactors par Cluster
Slod

By marking a checkbox opposite the required item you can choose whether to display it or not. Besides, yangan ch
its order by pressing the Move up or Move down buttons.

L¥ @2dz R2y Qi ySSR (GKS 5Aa]1 al Ll LJXSIFrasS OfA0] (KS &Kz

Sant fsectors) | End [secions) | Stad CHSheot) | End CHShex)

021 504D 61 14

300h  ZIEFETFRN 02
235FE300h  3ETFEFFAh 504D 61 15 FEFE 34 1E
800h  3ETFEFFM 02021 FEFE 34 1E

Properties Bar
The Properties Bar providedanmation on the selected at the moment partition/hard disk:

For a hard disk

1 Model,

9 Serial number,

1 Type of hard disk (basic or dynamic),

9 Total size (in GB),

1 Information on geometry of the disk (amount of sectors per track, heads and cylinders).
For a parttion

9 Drive letter assigned to the disk,

1 Volume label (if available),

1 Type of the logical disk,

91 File system (represented by the color of the graph and the selected bar),
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1 Total size, used space and free space (in GB or MB).

Besides you can modify practicadlyy partition property by clicking on the required value.

Legend Bar

The Legend Bar explains the color scheme used for disk and partition presentation. You can hide (or show) the bar w
the appropriate Main Menu item: View > Disk Map Legend. Wheradtigated it can be found at the bottom of the

Explorer Bar
The program distinguishes between the following types of known file systems:

-FAT16/32
-NTFS

- Linux Ext2/84
- Apple HFS

Status Bar
This is thébottom part of the main window. The Status Bar displays menu hints, for each item the cursor points to.

The user can hide (or show) the bar with the appropriate Main Menu item: View > Status Bar.

Settings Overview

The Settings dialog is available from #ain Menu: Tools > Settings. All the settings are grouped into several sections,
which functions are described in the following paragraphs. The list of sections is placed on the left side of the dialog.
selecting a section from the list, you can opeseaof options.

Q To get a detailed description to any setting, control, or field of the program just click the
hint button and then the object you ned.

General Options

Ng General options

Partition Abgrment Mode

Wista El
Align partitions according to the nies usad in Windows Vista and later 05es.

Check: F5 integrity policy

Oz 3

Standand protection from data loss with acceptable paformance. The file system
inbegrity will be checked for each volume only once just before accomplshing
data-senstive operations

Deta Loss Protecton mods

Reset B

Mediam protection from data loss

This section contains a set of general options that will be taken into account during any operation carried out with the
program:

9 Partition Alignment mode There are three options you can choose from:
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- legacy5h{ YR 2AyR2g4a h{Sa 0ST2NB +Aaill NBIdzANBR
or 63 sectors to address and access sectors correctly. It was OK, until 4K hard drives came intéreaene.
partitions are aligned this way on this type of disk, each logical cluster is linked to two physical 4K clusters
thus resulting in a double readrite operation.

- Vista Since Windows Vista, operating systems do not use the archaic CHS (cylindes#iota)/addressing
scheme, but the Logical Block Addressing (LBA), where sectors are addressed continuously over the who
disk drive. It is optimal for both, 512B and new 4K disk drivers.

- Inheritance Select the option to disable automatic alignment oftjiens.

1 Check FS integrity polichccomplishment of any datensitive operatiorfresize, move, merge, redistribute,
change cluster size,etd)da LI GSYydAlf S6AGK RFEGF f2aad ¢2 YAYAYA
yourfilesystemBF2NBE GKA& (Ge@L)S 2F 2LISNFGA2yas RSaALAGS (K
several options to let you choose, which is best for you:

- Always Maximum protection, but minimal performance. The file system integrity will be checked each time
AGQa ySOSaalNB (2 3dzr NI yiSdskdateS YI EAYdzy LINRGSOU

- Once Standard protection with acceptable performance. The file system integrity will be checked for each
volume only once just before accomplishing dansitive operations.

o

- Neverb2 LINRGSOGA2YS odzi YIFEAYdzY LISNF2NXYIyOSed LT &
not use this option.

9 Data Loss Protection modd o guarantee safety for your information when a daémsitive operation has been
abruptly interrupted as aasult of a computer reset, or a power outage, there are several techniques, that
correspond to the options below:

- Donotprotectb2 LINRGSOGA2Y X o6dzi YIFEAYdzY LISNF2NXYIyOSo
from a power outage, or an accidentaiset of your computer, please do not use this option.

- Reset Standard protection with acceptable performance. Maintaining a special journal, our program
enables to automatically complete a dadansitive operation interrupted by an accidental reset ofryou
computer from our bootable recovery media, thus reviving the corrupted partition.

- Power lossMaximum protection, but minimal performance. Besides journaling, our program will also
disable cache of your disk when accomplishing d&fasitive operationsa avoid data loss even in case of a
power outage.

General Copy and Backup Options

Eyf General copy and backup options

oA

Hdd raw processing
Copy an entire hard disk sector by sector without taking into account its partition
structure

Parttion raw processng

Copy/Backup each pariion sector by sactor. All sectors will be processed one by
one (even unused sectors). Requires more time to complete the operation

V| Skip OS awdiary files
Choose this option to skip OS awdiary files ke pagefile sys. hibedi sys etc ). This
will reduce operation time and backup image size
This section contains a set of options that will be taken into account dodpg and backup operations:

1 HDD raw processingMark the checkbox to copy/back up a hard disk in the seayesector mode, thus
ignoring its information structure (e.g. unallocated space or unused sectors of existing partitions will be
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processed as welllhis can help to avoid problems with hidden data created by certain applications or the
system administrator. However, it will take more time to accomplish the operation.

Partition raw processingMark the checkbox to copy a partition in the seebyrsector mode to successfully
process unknown file systems. However it is not recommended to enable this option when working with
supported file systems as it takes more time to accomplish the operation.

Skip OS auxiliary filedMark the checkbox to skip OSxdliary files (like pagefile.sys, hiberfil.sys, etc.), thus
reducing the operation time and the resulted size of the backup image.

Hot Processing Options

V| Enable hot processing

Hot processing technology
Microsoft Volume Shadow Copy Service 3]

Microsoft Volume Shadow Copy Service is a relisble technology designed to back
up volumes being locked by numerous active transactions of VSS supporting
applications. Microsoft VSS technology requires over 300 MB of free space on
any mounted NTFS volume for temporary data. This technology is provided for
Windows XP and newest Windows versions, but unavaidable for old versions of
Windows (S8/ME/NT/2000)

Addtional options

Always use hot processing

© Use hot processing only when partition is locked

Hot processing temporary dive

C

=]

Number of attempts to stat VSS: 3

Timeout between attempts §n seconds). 120
V| Switch between Hot Processing technologies

In this section you may odigure the hot processing mode:

T

Enable hot processingMark the checkbox to enable the so called hot data processing mode that is specially
designed to process data without restarting your operating system.

Hot processing technologyFrom the puldown list you can select the required hot processing technology.

Always use hot processingelect the option to process partitions without making them locked. Thus you will
be able to keep working with them as usual.

Use hot processing only when partition is leed. Select the option to use the hot processing only when
partitions are locked and cannot be processed without restarting the computer. Please keep in mind, that onc
you start any operation on a partition in this mode, it will automatically be locketidprogram, thus you

won't be able to keep working with it as usual.

Hot processing temporary driveHere you can select a disk drive that will be used to store the temporary hot
backup data (by defaui C:).

Attempts to start VSSHere you can set homany attempts to start Microsoft VSS the program is to do before
automatically rebooting the system and accomplishing the operation in a specialipaobde.

Timeout between attempts (in secondsHere you can set a time period between different attenptstart
Microsoft VSS.

Switch between hot processing technologieslark the checkbox to automatically switch betwdearagorHot
Processing and Microsoft VSS if one of them is unavailable at the moment.
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Partitioning Options

Enable 64 KB clusters for FAT16

Choose this option to enable 64 KB clusters for FAT 16 partitions. With this setting,
you will be able to create FAT 16 parttions with capacity up to 4 GB. Please note
that only Windows NT famiy systems will ba able to access such paritions

Confirmations
7| Ask for volume label before partition delete

Ask confimation when convesting FAT16to FAT32

This section contains a set of options that will be taken into account during partitioning operations:

1 Enable 64 KB cluster size for FATMark the checkbox to enable 64KB clusters for FAT16 partitibns.ybu
will be able to create FAT16 partitions up to 4GB in size

Due to the maximum cluster size of 32KB for Windows 95/98/ME or MS DOS, FAT16
partitions larger than 2GB are not reliably accessible under these operating systems.

1 Request confirmation before partition deletionMark the checkbox to activate an additional security
mechanism. Thus when going to delete a partition you will be automatiedjuested to enter its label.

1 Request confirmation when converting FAT16 to FATBRrk the checkbox to automatically request
confirmation before converting FAT16 to FAT32. There are a number of situations when this kind of conversic
is the only way outo accomplish the operation. For instance, you are going to migrate your system to a larger
hard disk with the proportional resize of existing partitions, what is very convenient. As a result you can get
original FAT16 partitions go beyond the 4GB liftiis without conversion to FAT32, this operation will in no
way be possible to accomplish. The same goes for any copy hard disk/partition or restore hard disk/partition
operation involving an extra upsizing.

Virtual Mode Options

Operations mode
J| Alow vitual mode
Set this option on to cany out all the operations vitualy. You will be able to

commit the changes or rolback all of them or the last one. ¥ you switch this
option off, the operations will be camed out immediately

Close progress dialog automatically
Set this option on to automatically close the progress dialog after committing the
changes

In this section you may configure the virtual mode:

1 Allow virtual mode Mark the checkbox to enable the virtual mode. It is an effective way of protection from any
troubles, since no operation will be executedtil confirmation, thus giving you a second chance to weigh all
pros and cons of this or that particular operation.

A We strongly recommend you to enable this mode.

9 Close progress dialog automaticallilark the checkbox to automatically close the pegg dialog after
accomplishing operations.
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Log Files Options

Loy Log files options

Choose a storage ife span for the stubact log file. Pleass note, once the defined pesiod

has been eqired, the file will be smptied.
@ Ifinle

Marurnal

Custom

In this section you can specify a storage life span fosthbact.log file
1 Infinite not to empty the file ever;
1 Minimalto have the file emptied all the time;

9 Customto set a certain storage life span for the fiRlease note, once the defined period has been expired, the
file will be emptied.

LINPOf SYa 6AGK GKS LINPINI YI 2dzNJ { dzLJLI32 NI

: We strongly recommend you not to choose the Minimal option, as in case of having
help you out.

Viewing Disk Properties

The main tool® view irdepth information on the properties of hard disks is bk Map It represents the actual state
2T GKS O02YLlzi SNN& KINR RAa&al1a®
Generally the hard disks are represented on the map by rectangular bars, which aisim somalisized bars. The small

sized bars represent logical disks (partitions). When you select adegg bar, théexplorer Badisplays information
about the disk in a bright, graphical form.

' Basic Hard Disk 1 {FUJITSU MPF3102AT)

Type: Basic Hard Disk Drive
Total size: 35GB
Sectors per track: €3
Heads: 255
Cylinders: 1245

’_ Create an image of the entire disk
bds)  Back up &l the data this hard disk contains. All the paititions on this disk will be added to the archive,

S Restore an im: of the entire disk
@j Warning: This operation wil delete all the data on this haid disk. Al the pattitions will be replaced with cnes from
the mage you have chosen. You may also be asked to restaet your computer during thes operation

= Copy the entire hard disk
@ Create a copy of the entire haed disk
Al the patitions on this disk wil be copiad on the specified targat disk,
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The model and serial number of the disk serve as the title of the browsed page. The disk layout is shown in form of a
circular graph, where the color of a sector corresponds to a file systemag@mopriate partition. On the right you may
see a table, which contains the following information:

1 Type of hard disk (basic or dynamic),
1 Total size (in GB),
1 Information on geometry of the disk (amount of sectors per track, heads and cylinders).

Below thee is a list of available wizards. If you click a corresponding record the appropriate wizard will be started. All
RSFldzZ & O fdzSa F2NJ GKS 2LISNIGAZ2Y LI NFYSGSNB gAft O2N
description of taks that can be performed by the wizard. This nullifies the possibility of selecting the wrong wizard.

Logical Disk (G:)

Volume letter: (G:) Sernal number: 74S3EASF
Volume label: FAT32-LINLX Partition ID: 008 FAT32
Type: Primary Total size: 68GB
File system; FAT32 Used space: 57GB
Sectors per boot: 36 Free space: 1GB
Sectors per cluster: 8 Aclivity. Inaclive

Hidden state: Not hidden

-~ 7 Create an image of the logical disk
g Back up all the data this logical disk conlains

7 Restore the logical disk from an imaqe
ég Warmning: This operation will delete all the data on thes logical disk and replace them fom the image you have
= chosen. You may also be asked to restart your computer during this operation.

(3 Copy the selected partition
& Create a copy of the patition. A new pastition wil be created and all the data wil be copied there.
= You can create an exact copy, of copy only the area that is occupied by data.

When you select a smadized bar (i.e. corresponding to a logical Yliible Explorer Bar will display information on it as
well. The page title will contain a drive letter, which is assigned to the disk. The disk layout graph will be colored in
accordance with the volume ratio of the used space to the free space (the dilghied sector). The table on the right
will contain the following information:

1 Volume label (if available),

1 Type of the logical disk,

1 File system (represented by the color of the graph and the selected bar),

1 Total size, used space and free space (in GBBE)r
Below there is a list of wizards, which may be called for this disk. All default values of parameters will correspond to t
disk settings.
Data Backup and Rescue

In this chapter you will find all the information necessary to establish a reliablepdatiaction system.
Creating Backup Images

Simple Backup Wizard Startup
1 Inthe Main Menu: seledVizards >SimpleBackup
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There are other ways to start up this function, please cattghe Interface Overview
chapter to know more on the subject.

Simple Backup WizardSetup
The wizard offers the following steps to accomplish the backup operation:

1 The object to back upYou can back up either antire disk or separate partitions of the disk (primary,
SEGSYRSR 2NJt23A0ltod Ly OFLasS 2F oFO1Ay3a dz2J Iy §
such disk elements as the Master Boot Record (MBR) and the first track of the $lard@itds can be very helpful
for serious disk recovery procedures.

Name Type R~
G My Computer My Comprter
= [l [5] Basic Hard Disk 0 (VMware, VMware Vitual S SCSI Disk Dev) Intemal Hard Disk Drive
= [l 5 First Hard Disk Track First Track
[E MeR .
€ Local Disk (C) Primary N
[7] Basic Hard Disk 1 (VMware, VMware Vitual S SCSI Disk Dev) Intemal Hard Disk Drive
5% First Hard Disk Track First Track
(& Master Boot Record MER

1 Name and location of the resulted imag®rovide a file name for the new image and its exact locafibe.
program automatically offers an easy to understand name containing the date and the time of the archive
creation, which can anyway be modified.

Select a folder whene archive should be placed and specify archive name. Archive name will be used as a
subfolder where backup data fles will be stored

Archive location: |G-/arc_test/ w K =
Name Size | Date
=1l My Computer

3 [5] Local Dsk 122

1 [=] Local Disk (E)

1 [F] Archives 159

4[] images (h200.01.164%e) (7))

7 ] Metwork
Archive detais
Archive name are_fesi|
Estimated archive size: 2MB

Space avaiable on backup destination: 38 GB

The program automatically calculates size of the future archive and informs the user ab:
space available on the selected destination.

Result

After the backup operation is completed you receive an ienafjthe selecte@bject This image is placed into the
specified destination, its features defined by the wizard.
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Available operation scenarios:

9 Backing up a hard disk or patrtition to a network drive

Restoring System and Data

The program includes a convenient and reliable restore wizard. With its help you can restore all types of backup imag
created with the program. It provides easy to understand instructions to configure and perform all the necessary

settings. Mor@ver you can get an idepth description to any setting, control, or field of the wizard just by clicking the
hint button and then the object you need.

Startup

M Inthe Main Menu: selediVizards > Restone

There are other ways to start up this function, please consult tinéerface Overview
chapter to know more on the subject.

Setup
The wizard offers the following steps to accomplish theorsbperation:

1 A backup image to be restored’he Browse for Archive page enables to find a backup image you need.

%) Show al -] & & &%

Type Creation Date Source Object Size C
9/2/2009 5:06:03 AM  Filedawel Anchive 4KB
ﬁ 97272009 223300 AM  Local Disk (C:) 4339 GB
a 922009 22101 AM  Basic Hard Disk 1 (Vivhware, Wiwane Virbsal 5 SCS51 Disk Dev) 10GEB
i [
E‘-‘ftﬁu Fll-“, ‘e
Archive Fle Detals
Comment. My documents
Backup date: 5722009 5:06:03 AM Total size 4 KE (4,096 Bytes)
Archive size: 445 Bytes
Fa G:/arc_doc/FLOODOO0000000000000. archive pfi
Base archive

To get a cleacut picture on properties of the miired image, just click on it and the section below will (i.e.
Archive File Details) display a short description.

1 A place to restore Selecting the destination, please notall contents on the disk selected for restoring
purposes will be deleted durirtge operation.

Basic Hard Disk 0 (VMware, VMware Virtuad S SCS1 Disk Dev)

I ©) Local Disk (C:)

493.9GB NTFS
Basic Hard Disk 1 (VMware, VMware Virtual S SCS1 Disk Dey)
U ©) Local Disk (E) ] © local Disk... @) ... I I ©) (Unalloc
" 34GBFAT32 | 2 4GB NTFS 14G. 2268

To help you get a cleanut picture of the operation outcome, the program allows inspecting the resulted disk
layout.
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Restoring Patrtition:

1 Siz of the restored volume and free space before and after it on the disk.

Geometry Restore Options
Please spacfy the size of the mstored partition 2470 5 36MB-2470 MB
Please specfy size of free space before the parttion: 0 * OMB-2434MB
Please specfy size of free space after the parttion 0 * OMB-2434 MB

1 Drive letter assignment after restoreThe pulidown list contains vacant drive letters thean be associated
with the restored partition.

Partition Restors Options
Aasign tha following drive letter: | F £

Restoring Hard Disk:

1 Copy data and resize partitions proportionall¥f this option is activated, the prograproportionally changes
the size of partitions keeping their relative order intact. The option can be useful when restoring to a larger ha
disk.

1 Perform surface testDefine whether the surface test will be accomplished during the operation or not.

Your hard disk after the changes
Basic Hard Disk 1 (VMware. VMware Virdual S SCSI Disk Dey)

E QL Disk (%) l ©) Local Disk ©) I I @) (Unalloc
3AGBFATIZ 2ZAGBNTFES 146G 22GB
Hard Disk Restore Options

Copy data and resize patitions proportionally

In this mode, the Wizard changes the size of partitions in the same proportion, with keeping intact their
relative order. This option can be usaful in restring an image of hard disk to a larger one.

Pedorm suface test

Set this option ff you want the Wizard to perform the surface test on the target hard disk. In this case, £ the
program finds bad and unreliable sectors &t will mark them as unusable ones

All contents on the disk selected for restoring purposes will be detéduring the
operation.

Result

The wizard will restore the archived data, and make it available to use in the operating system.

Adjust OS Wizard

/\ To make Windowdootable on different hardware, please additionally complete tHe2P

Available operation scenarios:

1 Restoring a system partition from a network drive

1 Restoring a system partition from a local drive

Copy Tasks

In this chapter you will find all the information necessary to make a copy of a hard disk or a separate patrtition.
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Cloning Hard Disks

You can clone a ha disk of any file system. During the hard disk copying process, the program moves controlling
records of used partitioning scheme, the bootstrap code andRona { LI NI AGA2yad ¢KIF GQa 4|
substituted by simply copying all @hsk patitions.

Copy Hard Disk Wizard

The Copy Hard Disk Wizard is a traditidika wizard. By going through its steps, you configure all the necessary
settings to launch the copy operation. To minimize the possibility of making any mistake, the wizardpeawmiiary
information on every single option. Moreover you can get adepth description to any setting, control, or field of the
wizard just by clicking the hint button and then the object you need.

A You need at least two hard disks to carry out this operation.

Startup
f Inthe MainMenu:seleéd AT I NR&a B / 2L® | FNR 5AaiX

There are other ways to start up this function, please consult theerface Overview
chapter to know more on the subject.

Setup

The wizard offers the following steps to accomplish the copy hard disk operation:

1 The hard disk to copy Select a hard disk you want to copy.

On this page, you can choose a hard disk you would like to copy. All partitions from this hard disk will be copied
to the destination you will choose on the next page.

Basic Hard Disk 0 (VMware, VMware Virtual S SCSI Disk Dev)

. @) Local Disk (C:)

7saucuauu*|(vuwae.vu-nmm[\sscsm*oev)
5

B @) Local Disk (E) I ©) LoclBasic Hard Disk 1 (VMware, VMware Virtual $ SCSID
Bl 3 4Ge AT 24GENTFS 2G| [0 (W Z2GE

1 The target hard diskSelect a hard disk (if several) where all data of the source disk will be copied to.

Select a target hard disk. Al data from the source hard disk will be copied there. During copy operation, target
disk content wil be deleted

' Basic Hard Disk 0 (VMware VMware Virtual S SCSI Disk Dev)

l L) Focd Disk (C2) [Basnc Hard Disk 0 (VMware, VMware Virtual S SCSI Disk De'.')l

499 9 GB NTFS

1 Copy parametersThe wizard enables to specify the following options:
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Choose copy options that sut best your task
Copy options:
HDD raw copy

Parttions raw copy

Resize options:
Remove free blocks between parttions
V1| Copy data and resize parttions pmood»ona?y

7, Mark the checkbox to peoportionally change the size of panttions while keeping ther
(1) relative order intact

" Tip: This can be very convenient when migrating to a larger hard disk

Copy options

- HDD raw copyo copy the hard dik in the sectoby-sector mode, thus ignoring its information structure (e.g.
unallocated space or unused sectors of existing partitions will be processed as well). This can help to avoid
problems with hidden data created by certain applications or trstesy administrator. However, it will take
more time to accomplish the operation.

- Partition raw copyto copy the ondisk partitions in the sectapy-sector mode to successfully process
unknown file systems. However it is not recommended to enable thimopthen working with supported file
systems as it takes more time to accomplish the operation.

Resize options

- Remove free blocks between partitionsot to keep blocks of free space between partitions on the targeted
hard disk.

- Copy data and resize pttions proportionally to make the program proportionally change the size of
partitions keeping their relative order intact. The option can be useful when upgrading the hard disk to a large
one.

Result

After the operation is completed, you receive a fiillpctional duplicate of the existing hard disk.

To make Window$ootable on different hardware, please additionally complete tH2P
Adjust OS Wizard

Available operation scenarios:

1 Migrating system to a new HDD (up to 2.2TB in size)

Cloning Partitions

You can duplicate partitions to protect oneself fralmwntime in case of a system malfunction or for cloning sample
partitions. The program enables to duplicate all partition data including files, the exact structure of directories and file
system metadata (location of files, security information, accesdgag, etc.).

The Copy Partition Wizard will help you copy a partition of any file system. To minimize the possibility of making any
mistake, the wizard provides auxiliary information on every single option. Moreover you can gedeptlindescription
to any setting, control, or field of the wizard just by clicking the hint button and then the object you need.
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Startup

¢ Inthe Main Menu: select A 1 I

NRa B /2L tINIAGAZ2YX

There are othe ways to start up this function, please consult thaeterface Overview
chapter to know more on the subject.

Setup

The wizard offers the following steps to accomplish the copy partition operation:

1 The partition tocopy. Select a partition you want to copy.
On this page you can choose a volume to copy

Basic Hard Disk 0 (VMware, VMware Vitual S SCSI Disk Dey)

I ©) Local Disk (C:)
439.9GB NTFS

Basic Hard Disk 1 (WMware, VMware Virtual S SCS1 Disk Dey)

@ @) Local Disk (E:) '] © local Dis... Q) - I I ©) (Unallo
34GB FAT32 | B 24GBNTFS ||| 146G, 22GB

9 Destination disk Select a hard disk with enough unallocated space to perform the operation
The wizerd will create 3 copy of Local Disk (F:)from Basic Hard Disk 1 (VMware, VMware Virtual 5
SCS1 Disk Dev)
The copy vl be created on Basic Hard Disk 3 (VMware, VMware Vitual 5 SCS51 Disk Dev)
Fleasa sslact where to create a copy:

Basic Hard Disk 3 (VMware, VMware Virdual 5 SC51 Disk Dev)

I ©) (Unallocated)
19.9GB

The program enables to copy a partition to a block of free space, which is smaller than t
partition itself, taking into account only actual amount of data.

1 Copy parametersThe wizard enables to specify the following options:
Your hard disk after changes

Basic Hard Disk 2 (WVMware, VMware Virtual 5 SCS1 Disk Dev)

I ) (Unallocated)

" E

Whene to place a copy
Please speciy the size of the new partiion 3624 > F9MB - 20473 MB
Please specy size of free space before the pariion: 0

L0 MB - 20434 MB.
Please speciy size of free space afterthe partiion: 16843 & 0 MB - 20,426 MB.

- Partition size Define the size (in Mb) ofi¢ copied partition.

- Free space beforeDefine the position (in Mb) of the copied partition relative to the beginning of the available
range of disk space.
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- Free space afterDefine the amount of trailing free space (in Mb) at the end of the availaliger of disk
space.

Partition size and position may also be defined by using the deagl-drop technique. To do
that, just carry out the required opeation on the Disk Map.

Result

After the operation is completed you receive a fully functional duplicate of the existing partition.

Tomake Windowsbhootable on different hardware, please additionally complete tH2P
o Adjust OS Wizard

Partition Management

In this chapter you will find all the information necessary to carry out partitioning operationmsigo by the program.

Basic Partitioning Operations

Here you can learn how to accomplish basic partitioning operations (create, format, delete).

Creating Partitions

The program provides the ability to create a new partitiwithin a blockof un-partitioned space
Restrictions
1. Do not use the Create Partition function in order to undelete the last deleted partition.

2. The program allows creating new partitions only within blocks egpartitioned space. It cannot convert a free
space on an existing partition & new partition.

3. The program cannot create new partitions on Dynamic Disks.
Create Partition Wizard Startup

f IntheMainmenu:sele@ AT I NR& B / NBIGS tFNIAGAZYX

There are other vays to start up this function, please consult thaeterface Overview
chapter to know more on the subject.

Dialog Startup
1. Select a block of free space on the Disk Map;

2. Select in the Main MenWPartition > Create Pdition .
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There are other ways to start up this function, please consult tinéerface Overview
chapter to know more on the subject.

CreatePartition Wizard Setup

The wizard offers the following steps to accomplish the operation:

1 Partition destination Select a hard disk (if the computer has several hard disks) and then choose position for
the future partition on the disk: at the end (prefdiie), at the beginning or somewhere in the middle between
other partitions.

Qi this page you can select hard disk and the place whene 1o creste a new parttion
Basic Hard Disk 0 (VMware, VMware Vidual 5 SC5| Disk Dev) -
I ) Local Disk (C:) I ) data (£
2329 GB NTFS 217 GE NTFS

Basic Hard Disk 1 (VMware, VMware Virtual 5 SC51 Disk Dev)

I @) Local Disk (7] L

Basic GPT Hard Disk 2 {(WMware, VMware Virual 5 SC51 Disk Dev)

I h. I r_ﬂ -:_lFr1.|I|-::-|::..rIe:rI]
| The partition will be created htrt] | =

Lisa the butbons to mowe the madoesr or drag maroes by mouse. A new padition will ba created whers

the marker is.

By default, the program allows you to create a new partition only as thstlarimary or as

Q the last logical drive within the extended partition. However, by activating the advance
mode on the first page of the wizard you can remove this restriction that in its turn might
result in some boot problems.

9 Partition size There is o restriction on size of the future partition, merely depending on space available on the
hard disk.

If there is not enough free space in one block, the wizard enables to redistribute free space, joining all free
space blocks together into one united blaokd moving partitions when necessary. If the total amount of free
space is still not enough, it is possible to split a fragment of space from one of the existing partitions, thus

resizing it.
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Your hard disiz bafore the changes
Sy ————— ..&;..“iﬁie.ﬁﬁﬁus.ﬂ.l.[:‘i;k.l;'.ie;-r]. —
: I I @) (Unallocated)
Your hard disk: aftar the changes

Basic GPT Hard Disk 2 (WVMware, Viware Vidoal 5 5051 Disk Dev)

I I ) Local Disk (%)

If a partition to resize is locked and cannot be processed, the wizard makes the system
reboot to create the partition and then automatically boots the system again. (The
rebooting mechanism is different for different veions of Windows.)

You can also choose whether the future partition will be primary or logical by marking the appropriate
checkbox.

9 Partition properties On the next page of the wizard you can set a number of additional parameters:
Your hard disk: after the changes

Basic GPT Hard Disk 2 (VMware, VMware Virtual 5 5C51 Disk Dev)

I l W) New Volume (E:)

Wolums labal: | New Yolums
Azsign the folowing diva latter: | E Tl

- Partition type. From the pulidown list select a file system the newly created partition will be formatted to,
otherwise the partition will remain unformatted (so that it wilbt be ready to use).

- Volume label Enter a label for the selected partition in this textual field. It is an irrelevant parameter usually
used for drive identification.

- Surface test levelDefine the level of the surface check to make the programifa@iand unstable sectors and
mark them unusable in the file system metadata.
Dialog Setup

Initially the program suggests some consistent values for all parameters. In most cases, you can just press the Yes
button to confirm the operation.
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Are you sure you wanlt lo create a new parlition on disk 37
You are about to create a new parition in (Unallocated). 19.9 GB arca. Flease select size.
position and file sysiem of the new partition.
Basic Hard Disk 3 (WMware, VMware Vifual 5 5C5] Disk Dev)
I I 1) New Volume (H:) I
19.9GE NTFS

Create new pariition 23 [Prmary parttion [

Plaasa spacify new partibon size 20473 - TMB-20473 MB

Please specty size of free space befors the parition: |0 * OMB - 20,465 MB

Please specify size of free space afterthe patition: 0 = OMB-20472 MB

Please select file system for new partition: | NTFS El

Flease anter new volume label: HNeaw Voluma

Flaasa spacify dive letter H 3

%) [More options | Yes J l ] |

91 Define whether the partition will be Primary, Extended or Logic®ou can choose the desired partition type
from the pultdown list. As a matter of fact, the available alternativesdamentally depend on the selected

block of free spacewithin the Logical free space, only Logical partitions can be created; Within the Primary fre

space, both Primary partitions or the Extended Partition can be created.

1 Partition Size Define the siz€éin Mb) of the new partition.

1 Free space beforeDefine the position (in Mb) of the new partition relative to the beginning of the block of free

space.

9 Free space afterDefine the amount of trailing free space (in Mb) at the end of the new partition.

Partition size and position may also be defined by using the deagl-drop technique. To do
that, just carry out the required operation on the Disk Map. The virtual operations are to
available.

1 File system for new partitionFrom the pulidown list £lect a file system the newly created partition will be
formatted to, otherwise the partition will remain unformatted (so that it will not be ready to use).

1 Volume label Enter a label for the selected partition in this textual field. It is an irrelevardrpeter usually
used for drive identification.

9 Drive letter assignmentThe pulldown list contains vacant drive letters that can be associated with the newly

formatted partition.

In addition, there is the possibility to make further detailed settingth¢algh the default values will do in most cases).
To activate the advance mode, you need to click the More options button at the foot of the dialog page. Depending ol

the chosen file system, the following options become available:
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| Usa 05 built in format routine

Flaase selact number of sectars per cluster: | 8 [=]
Please select number of seclors per boot

Please sslact number of oot entnes

\Rﬂm d-dat.ls.
1 Use OS buittn routine. Mark the option to restrict the available values according to the used OS.

1 Whether the surface test will be performedDefine the level of the surface checkrhake the program find bad
and unstable sectors and mark them unusable in the file system metadata.

1 The amount of sectors per boofrhis parameter is available exclusively for FAT16 and FAT32 file systems. Set
the number of sectors to be reserved for theot area on the partition with this spinner control.

1 The amount of root entriesThis parameter is available exclusively for FAT16 file system. Set the maximum
amount of files/directories to be placed in the Root Directory on the FAT16 partition.

1 The amount of sectors per clusterDefine the Cluster Size for the formatted partition with this spinner control.

A Number of available options depends on the selected file system type.

Result
After the operation is completed you receive a fully functionaligan.

Formatting Partitions

Any partition should contain some file system to be used for keeping data. The process of installing a file system is
commonly known as formatting. A huge variety of file systems have been developed these days.

Supported FileSystems
The program provides the ability to format partitions of the following file systems:

-FAT12 & FAT16
-FAT32

-HFS+

-NTFS

- Ext2

- Ext3

- Ext4

- Linux Swap v. 2
Wizard Startup

1 Inthe Main menu: seledVizards > Format Pakt (i A 2 y X
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There are other ways to start up this function, please consult tinéerface Overview
chapter to know more on the subject.

Dialog Startup
1. Select a partition on the Disk Map;

2. Select in the Main MenWPartition > Format Partition

There are other ways to start up this function, please consult tinéerface Overview
chapter to know more on the subject.

Wizard Setup

The wizard offers the following steps to accomplish the operation:

1 Partition to format. Select a hard disk (if the computer has several hard disks) anditeerduired partition to
format.

On this page, you can choose a volume you would like to format
Basic Hard Disk O (VMware, VMware Vitual S SCS1 Disk Dey)

[. @) Local Disk (C)) l l ©) data (Z)

2829GB NTFS 217GB NTFS

Basic Hard Disk 1 (VMware, VMware Virtual S SCSI Disk Devy)

l @) Local Disk (*)
433.3GB NTFS

Basic GPT Hard Disk 2 (VMware, VMware Virtual S SCSI Disk Devy)

I I ©) (Unallocated)

A As a result of this operation contents of the selected partition will be lost.

9 Partition properties On the next page of the vard you can set the following partition parameters:
Yowr hard disk after the changas
Basic Hard Disk 0 (WVMware, VMware Vidoual 5 SCS1 Disk Dev)

I ) Local Disk (C:) I ) data (Z:)

Volume label: | Mew Volume

- Partition type. From the puldown list select the desired file system type. In fact, the programlaiisppnly
those file systems that can correctly be placed to the selected partition, taking its capacity into account.
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- Volume label Enter a label for the selected partition in this textual field. It is an irrelevant parameter usually
used for drive idetification.

- Drive letter assignmentThe pulidown list contains vacant drive letters that can be associated with the newly
formatted partition.

In addition, there is the possibility to make further detailed settings (although the default values wilhalist cases).
To activate the advance mode, you need to mark the appropriate option at the foot of the page. When it is marked, tt
next page enables to define:

7] Use OF buk in format roctine

Pisase salact sectorns e ClUSteT
2]

1 Use OS buikn routine. Mark the checkbox to restrict the available values according to the used OS.

1 Whether the surface test will be performedDefine the level of the surface check to make the program find bad
and unstable sectors and mark them waible in the file system metadata.

1 The amount of sectors per boofrhis parameter is available exclusively for FAT16 and FAT32 file systems. Set
the number of sectors to be reserved for the boot area on the partition with this spinner control.

1 The amount & root entries. This parameter is available exclusively for FAT16 file system. Set the maximum
amount of files/directories to be placed in the Root Directory on the FAT16 partition.

1 The amount of sectors per clusteDefine the Cluster Size for the formedtpartition with this spinner control.

A Number of available options depends on the selected file system type.

Dialog Setup

Initially the program suggests some consistent values for all parameters. In most cases, you can just press the Form:
button to confirm the operation.

: 4’ Are you sure you want to format volume (F:)?

You are about to format volume (F:) [No label]. NTFS. Your computer may
no Jonger boot or work comectly

Please select new file system:  [ZNACHINNN ~ |
Please enter new volume label: | New Volume

¥) More options ‘ Format | | No

1 File systemFrom the puldown list select the desired file system type. In fact, the program displays only those
file systems that aacorrectly be placed to the selected partition, taking its capacity into account.

1 Volume label Enter a label for the selected partition in this textual field. It is an irrelevant parameter usually
used for drive identification.
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In addition, there is thg@ossibility to make further detailed settings (although the default values will do in most cases).
To activate the advance mode, you need to click the More options button at the foot of the dialog page. Depending ol
the chosen file system, the following tigns become available:

#| Use OF built in format routine

Plaase sslact number of sectors per cluster: | 128 [=]

Please sslect number of sectors per boot:

Fleass salect number of oot entries:

Restone defauls

1 Use OS buittn routine. Mark the checkbox to restrict the available values according to the used OS.

1 Whether the surface test wilbe performed Define the level of the surface check to make the program find bad
and unstable sectors and mark them unusable in the file system metadata.

1 The amount of sectors per boofThis parameter is available exclusively for FAT16 and FAT32 filnsySet
the number of sectors to be reserved for the boot area on the partition with this spinner control.

1 The amount of root entriesThis parameter is available exclusively for FAT16 file system. Set the maximum
amount of files/directories to be placed the Root Directory on the FAT16 partition.

9 The amount of sectors per clusteDefine the Cluster Size for the formatted partition with this spinner control.

A Number of available options depends on the selected file system type.

Result
After the opeation is completed you receive a fully functional partition formatted to the specified file system.

Deleting Partitions
Wizard Startup

f IntheMainmenu:sele@ AT F NR&E B 5StSiGS tINIAGAZYX

There are other ways to start up this function, please consult tinéerface Overview
chapter to know more on the subject.

Dialog Startup

In order to start the operation you should take the following steps

Launcher
1. Select a partition on the Disk Map;

2. Select in the Main MenWPartition > Delete Partition
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There are other ways to start up this function, please consult tinéerface Overview
chapter to know more on the subject.

Wizard Setup

The wizard offers the following steps to accomplish the operation:

1 Partition to delete Select a hard disk (if the computer has several hard disks) andtieeequired partition to
delete.

On this page. you can choose 3 volume you would ke 1o delete
Basic Hard Disk 0 (VMware, VMware Virtual S SCS1 Disk Dey)

l!)}l.ocduak(C:) l(_))daa(Z:)
282.3GB NTFS 217 GB NTFS

Basic Hard Disk 1 (VMware, VMware Virfual S SCS1 Disk Dev)
. ©) Local Disk (7) E
433.9GB NTFS

Basic GPT Hard Disk 2 (VMware, VMware Virtual S SCS1 Disk Dev)

I l @) (Unallocated)
569.8GB

‘ / ! You are sbout 1o destroy a bootable partition!

A As a result of this operation contents of the selected partition will be lost.

1 Merge free blocksAs a result of the operatioyou may get several blocks of the unallocated space on the hard
disk. So choose whether to merge them all and place at the beginning of the disk or at the end by selecting th
required operation from the puitlown list.

Merge fres blocks options
Do mot marps fres blocks s, |:|

Marge fraa blozks & the and o the disk

Merpe fres blocks at the beginning of the disic

Dialog Setup

Initially the program suggests you just to remove references to the selected partition from the Partition Table.

R

‘12 Are you sure you want to delete volume (F:)?

w You are about to delete volume (F:) [No label]. NTFS. Your computer may
no longer boot or work comectly

1[0 ot ask vohume lsbel next tme |

ves || N |
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1 Enter the volume label to confirm deletinglo confirm deletion of the selected partition, enter its Volume
Label. The current volume label is displayed above.

1 Do not ask volume label next timeMark the option to infbit confirmation next time you start the dialog.

Result

By default, the operation takes only a fraction of a second. However, the program waits until Windows completes the
modification of the disk layout.

Advanced Partitioning Operations

Here you can learhow to accomplish advanced partitioning operations.

Undeleting Partitions

When simply deleting a partition (without additional wiping) disk management software only removes references to it
the Partition Table, thus leaving the possibility to recavéater.

The program enables to find and recover these patrtitions. A restored partition will be fully functional, as long as other
partitions were not created, moved or exceeded the disk space occupied by that partition. That is why the program
offers this function only for blocks of free space.

The operation can be accomplished with the Undelete Partition Wizard.

Startup
f Inthe MainMenu:sele@ AT I NRa B ! YRSt SGS tINIAGAZ2Y&X

There are other ways to start up this function, please consult theerface Overview
chapter to know more on the subject.

Setup

The wizard offers the following steps to accomplish the undelete partition operation:

9 Free blocks to scan for lost partitionsChoose a free block from a tréike list of available hard disks.

Click: the check box nest to sy haed disk drive or free block you want to examine

Name Type
= Gl My Computer My Compuier
- [¥] [7] Bassc Hard Disk 3 (Viware, Viware Vitual 5 SCSI Disk Dev) Intemal Hard Di

S Urstocaiey [

The summary sze of fragment (3) to analyze is 19.9GB

1 Search methodBy default, the wizard selects the fastest seardthod for your operating system. In most
cases that will do to find any accidentally deleted partition. However if you're under Windows XP for instance
(the Conventional Search option is selected), but the deleted partition you're looking for has leasgsdawith
the Disk Management utility under Vista, the wizard won't be able to find this partition, unless you manually
select the appropriate option (Quick Search for Partitions Created by Vista or Later OS). Moreover if the wizal
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still fails to find tle partition you need, you can select the Thorough Search option to scan every single sector i
the specified search area to get the most accurate results.

Choose how to look for the deleted partitions:
@ Conventional search
Thorough search
¥ Show file systems search options

To know more on the available search methods, please use the context sensitive hint
system.

1 File system filter By default, the wizard will search for latlown file systems. However, by clicking on the
appropriate option on the second page of the wizard, you can specify only those file systems you need.

2 Hide file systems search options
| Al known fle systems |
FAT and FAT32 file systems
7] NTFS file system
Uinux B42 and B3 file systems
0S5/2 HPFS file system
Other {unksted) file system
To begin search, cick Next
1 A partition to undelete (if several). By default, the program searches records of any deleted partition ever
existed on the selected block of free space. So you can get several partitions to choose from.

EE Search delsled partiions from secter: 40 1o sacior 2787

The following partitions have been found:

-Fies:ﬂum .T'me .'Capam .Uu-dSm-::a- [ % Used
T NTFS Primary 199GB 853 MB 0
Stop search

Most likely the required partition will be found first. If so, you may abort the search operation by pressing the
Stop search button.

Result
After the operation is completed you receive a fully functional partition.

Changing Partitio n Attributes
This chapter explains how you can change partition attributes (Active flag, Hidden flag, Volume Label, etc.).
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Mark Partition Active/lnactive

The program enables to set an active/inactive flag for primary partitions of a hard disk. By defaaperating system
will boot only if its partition is active or bootable.

In order to mark a partition active/inactive you should take the following steps:
1. Select a primary partition on the Disk Map.

2. Select in the Main MenWPartition > Mark Partition agActive/lInactive.

There are other ways to start up this function, please consult tinéerface Overview
chapter to know more on the subject.

N~
Are you sure you want to set the volume as active?

You are about to set the volume (F:) [No label]. NTFS as active. ¥ you already
have active volumes, this action might render your system unbootable

!

e

Yes j No

3. The operation will be performed immediately after confirmation.

There can only be one active partition on a hard disk, otherwise your operating system \
z t s fail to boot.

Hide/Unhide Partition

The program allows you to hide/unhide primary and logical partitions. By default, an operating system does not mour
hidden mrtitions, thus preventing access to their contents.

In order to hide/unhide a partition you should take the following steps:
1. Select a partition on the Disk Map.
2. Select in the Main MenwPartition > Hide/Unhide Partition

There are other ways to start up this function, please consult tinéerface Overview
chapter to know more on the subject.

3. The operation will be performed immediately afteonfirmation.

It is strongly recommended not to hide the system partition. Otherwise your operating
system will fail to boot.
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Set Label of a Partition

The Partition Label is a small textual field (up to 11 characters) that is located in the partition's boot sector. It is
detectable by any partitioning tool and is used for notification purposes only.

In order to change a patrtition label you shoul@ézahe following steps:
1. Select a partition on the Disk Map.
2. Select in the Main MentPartition > Modify > Change Volume Label

There are other ways to start up this function, pleasonsult thelnterface Overview
chapter to know more on the subject.

3. Enter a label for the selected partition.

Are you sure you want to change label on volume (F:)?
- Please speciy a volume label for easier recognition of your volume

Please enter new volume label:  New Volume

| Yes 1 No

4. The operation wi be performed immediately after confirmation.

Hard Disk Management

In this chapter you will find all the information necessary to carry hard disk operations supported by the program.

Converting Dynamic MBR to Basic

The program allows you to convert a @gynic MBR disk containing simple volumes into a basic one while keeping its
contents intact.

In order to convert a dynamic MBR disk into basic you should take the following steps:
1. Select a dynamic MBR disk containing simple volumes on the Disk Map.
2. Selecinthe MainMenui  NR 5Aal1 B /2y@SNI G2 . FaioX

3. Set the required number of primary partitions if necessary. According to the DOS partitioning scheme a hard
disk can have up to four Primary partitions. If there is an Extended partition on the disk, a#yptimary
partitions are allowed. That is why if a dynamic disk contains several simple volumes the program enables to
choose the number of primary partitions. The rest of them if any will automatically be converted to logical disk
within the Extended puition.
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- s

@wmmmeomv

¥ the disc has more than four smple volumes, the first three of them will become
peimary partiions, and the rest will be converted to the logical ones

The hard dsk after convent

Basic Hard Disk 3 (VMware, VMware Virdual S SCSI Disk Dey)

l New Volume (H:)

The resulting basic hard disk can have no more than 1 pemary parttions
Please salect how many pemary parttions the basic disk should have

A

The program can only process dynamic diskstaoming solid simple volumes (without
extension).

Converting GPT to Basic MBR

The program allows you to convert a basic or a dynamic GPT disk containing simple volumes into a basic MBR disk \

keeping its contents intact.

In order to convert a basia@ dynamic GPT disk into a basic MBR disk you should take the following steps:
1. Select a basic or a dynamic GPT disk containing simple volumes on the Disk Map.
2. Selecinthe MainMenui  NR 5Aal B / 2y @SN

Extended partition.

-

-2 =

J

% Convert the basic GPT hard disk to a basic MBR hard disk?

¥ there are more than four volumes on the disk, only the first three may become
primary, and the rest - logical

The hard disk after convent

Basic Hard Disk 3 (VMware, VMware Virtual S SCSI Disk Dev)
I I New Volume (H:)
192GB NTES

The resuted hard disk should have at least 1 primary pastition(s)
Please sslect how many prmary paditions you need

2
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3. Set the required number gdrimary partitions if necessary. According to the DOS patrtitioning scheme a hard
disk can have up to four Primary partitions. If there is an Extended partition on the disk, only three primary

partitions are allowed. That is why if a GPT disk contains akewvelumes the program enables to choose the
number of primary partitions. The rest of them if any will automatically be converted to logical disks within the
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The program can only process dynamic GPT disks containing solid simple volumes (wit|
extension).

Converting Basic MBR to GPT

The program allows you teasilyconvert a basi¢BRdiskinto a basic GPdisk while keeping its contents intadthe
operation is quite safe for the edisk data, but you should know that only-6# Windows OSes since Vista are able to
bootfromthisi 8 LIS 2F RAA]1aADP0pA8 AXYR2dBOB{ IROORYYRBRIGSR 2y |
Al 62y Qi adGF NI dzZLJ F FGSNI GKS 2LISNIX A2y Aa 2SN
In order toconvert a basic MBR disk to a basic @RI'should take the following steps:

1. Select abasicMBRhard disk on the Disk Map.

2. Select in the Main MenuHard Disk > Convert to GPT hard disk

-]

IDE Hard Drive ATA Devi) to GPT?

Please Note! Despie the fact that al on-disk contents remain intact during the
operation, your OS may no longer boot comectly, for Windows XP 32:bt for instance

does not support GPT disks
[ h

'Q Are you sure you'd like to convert Basic Hard Disk 0 (VMware Virtual

3. The operation will be performed immediately after confirmation

A The program can only convert basic MBR disks.

Updating MBR

The program enables to overwrite the current bootable code in the MBR (Master BoatdiRbgdhe standard
bootstrap code. This can help to repair a corrupted bootable code of a hard disk resulted from a boot virus attack or &
malfunction of boot management software.

In order to update MBR of a hard disk you should take the following steps:
1. Select a hard disk on the Disk Map.
2. Select in the Main Menward Disk > Update MBR

There are other ways to start up this function, please consult tinéerface Overview
chapter to know more on the subject.

ol

1 Are you sure you want to update master boot record?
E== Cument MBR contents for hard disk number 0wil be lost after this operation. Your

computer may no longer boot comectly
—_—
| Yes ‘ | No
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3. The operation will be performed immediately after confirmation.

Extra Functionality

This chapter desilyes the supplementary functionality available in the program.

View Partition/Hard Disk Properties

The program enables to obtain-depth information on the properties of hard disks and partitions. Besides the general
information, such as capacity, usedasp or file system type it provides the possibility to get info on hard disk geometry,
cluster size, exact partition location, etc.

To get properties on a patrtition/hard disklease do the following
1. Choose a pation/hard disk on the Disk Map.
2. SelectintheMainMenut I NIAGA2y k!l I NR 5Aa]1 B t NRBLISNIASaX

There are other ways to start up this function, please consult inéerface Overview
chapter to know more on the subject.

-9 JmeSe)
General| | Fie System Info ]ﬁdvmced

Local Disk (C:)

Volume: label: [No label)
File system: NTFS
Type: Prmary
Capacity: 4393GB
536,868,814,.848 Bytes
1.048.571.904 Sectors
Used by data: 953GB(1%)
10,016,497 664 Bytes
19.563.472 Sectors
Free space: 4306GB (33%)
526.852,317,184 Bytes
1.029.008.432 Sectors

In the opened dialog information will be grouped according to its properties, thus by clicking tabs you can get
information youneed.

Volume Explorer

Volume Explorer is a special tool to browse and export contents of the local mounted/unmounted volumes formatted
FAT16, FAT32, NTFS, Ext2FS, EX8ESSfile systems. Besides it enables to acdeasagorbackups as regular fadds
to explorer their contents or to retrieve certain files.
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To launch the Volume Explorer you should diidk Viewtab in the Explorer Bar and then chodgelume Explorer

Disk View :M'rm | Archives | Help

Mame Size Modified
| & Sl CO/DVD Drives
(& = ) Hard Disks
+ _]1 Viware ViMware \idual 5 SC51 Desk Devi S00GB
5 [E] 2. VMware. VMware Vitual 5 SCS51 Disk Devi 0GB
#- [ 1. Pimary FAT3Z E) 314GE
= @92 Primary NTFS (F) 24GB
* m 97272009 £:19:32 AM
= — 5/2/2009 £:24:45 AM
o @3 P _oren E 1468
#- [54. Primary Linuee Swap 509.3 MB
1 [=] 3. VMware, Viware Vidual 5 SCSI Desk Devi 80GB

B @ [E] 4 VMware, VMware Vitual $ SCSI Disk Devi (GPT Disk)
Bl = O Viwad Drives

Call the popup menu for the selected file/folder (right click of the mouse button) to export it to some other location
(local or network drive, etc.).

@, Select a destination folder for the export operation -8 |
Lookin: | [2] Local Disk [C) E] e K X

@ Address:  C./

Disk Drives N-'.lme Date
BB localDekC)
@ +- 2 DVD AW Deive (D)
#- [5] Local Disk (E)

Metwork Places % [5] Local Dsk (F)
£ [] Aechives (G)
#- [E] New Vohume (H:)

[ ) [ Gows

Available operation scenarios:

1 Restoring separate files and folders from a backup

File Transfer Wizard

File Transfer Wizard is designed to make such operations as copying of separate files/directuuieéng of them to
CD/DVD as easy and convenient as possible. It may be of particular use in case of a system malfunction, caused eitl
a virus attack or files corruption, in order to get the system back on track again. Besides it provides geaes300
backups as regular folders to browse through their contents or copy required files.

Startup

M Select in the Main Menutools > File Transfer Wizard

There are other ways totart up this function, please consult théinterface Overview
chapter to know more on the subject.
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Setup
The wizard offers the following steps to accomplish the transfer operation:

1 Place to look for files/directorés. Select a source disk from the pddwn list in the left pane of the page. The

program enables to process both mounted and unmounted (without drive letter assigned) partitions. Besides |
is possible to map a network drive.

Source

5] Local Disk () —1‘} o X ¥

[N © 0DVDRW Drve (D) 4

[5] Local Disk (E)

[5] Local Disk F)

[Z] New Volume (H) £
@) Physical panttions

vy NEW VOLUME, Disk 1
CJ] Network places

Il Network -

1 Object(s) of operation Choose files/directories you want to copy and place them to Clipboard by pressing the
Add button. To delete a file/directory from the Clipboard, select it in the Cligbpane and press the Remove

button. You can also create a new folder, rename or irreversibly delete existing files/directories of the left pant

by pressing the appropriate buttons.
Clipboard Source
Name  Source Path ] Local Disk ) ] @ X ¥
limages F/images/
Name -
T TG By
—— i hibedi sys
% pagefie sys
» [35] someemd emd
: DVD RW Drive (D)
= [£] Local Disk (E)
[5] Local Disk (F)
! _

System Volume Information
Total data size: 132.8 KB

A Files/directories deleted from the Clipboard remain intact on source disks.

9 Destination to store the object(s)The File Transfé¥izard allows copying data to local or network drives, to
physical partitions (without drive letters assigned), or burning them to CD/DVDs. Choose the way the data wil
be stored.

There are several ways the Wizand can store your data. Plese select how would you ke to save the: data:
| Sove dola to local notwosk dives. |
Crvenwribe masting files
Save data to physical pariiions
Bum the data te CD or DVD
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Revision of changesrhe Transfer Summary page provides structurally divided information on all the actions
made in the wizard. Check the changes and come back to any step of the wizard (if necessary) by following tl
required hyperlink

Please overview the transfer options. You can retum to the comesponding page and change the options by cicking on title
hypedinks
Qbjects to trander
Object(s) selected: 1
Total data size: 1328 KB (136,024 Bytes)
Transfer destination
Destination path- c/
Space available on destination: 4906 GB (526,821,834 752 Bytes)
Overwrite existing files: No

After the operation is completed the required data will be placed into the specified destination.

Mount Partition

The program enables to assign or remavive letters of existing formatted partitions.

Assign Drive Letter

In order to mount a partition you should take the following steps:

1.
2.

Select a partition on the Disk Map.
Selectinthe MainMenu:  NIAGA2Y B !'aairdy S5NRAGS [ SidGSNKX

A

There are other ways to start up this function, please consult tinéerface Overview
chapter to know more on the subject.

3.

4.

Specify a drive letter for the selectgartition. Initially the program suggests some consistent value for this
parameter. So you may just press the Yes button to confirm the operation.

0]

% Assign a drive letter?
This allows access to the volume by using the drive letter assigned. The
assignment is not recommended f the volume contains a file system not
supported by your operating system

Assign the folowing drve letter: NN ~ |

However you can manugltefine the required letter by selecting it from the pdtwn list of available drive
letters.

The operation will be performed immediately after confirmation.

Remove Drive Letter

In order to urmount a partition you should take the following steps:

1.
2.

Selet a partition on the Disk Map.

Select in the Main MenwPartition > Remove Drive Letter
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There are other ways to start up this function, please consult tinéerface Overview
chapter to know more on the subject.

3. The operation will be performed immediately after confirmation.

Modifying drive letter of the system partition will result in inability to boot the operating

E system.
After having processed partitions with installed software, some programs may not run
properly.

Check File System Integrity

The program allows you to check integrdf a file system. It can be used to detect possible file system errors before
performing any operation on a partition.

To start the system integrity check you should take the following steps:
1. Select a partition on the Disk Map
2. Select in the Main MenuPartition > Check File System Integrity

There are other ways to start up this function, please consult tinéerface Overview
chapter to knawv more on the subject.

EE =
'\\ Check volume (C:) [No label]. NTFS for errors?

1 Please note that check operation needs exclusive access to the volume. You may be
asked to restart your computer to complete the operation

3. The operation will be performed immediately after confirmation.

View Logs

With a handy dialog you can study logs on any operation carried by the prog@make this job as easy as possible, all
the information is structurally divided, besides there is the possibility to see the disk layout before and after an
operation, what is very convenient.

In order to view logs on carried out operatiosedectin the Main Menu:Tools > View Log Files
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==
= B § & 7| [«

Session event
Started 9732009 at 12-40:12 AM. Frished at 12:40:29...

Started 9732009 at 12-40045 AM. Finished at 12:41:21...
Started 9732009 at 12-42:11 AM. Freshed at 12:4429
Started 3732009 at 12-45:04 AM. Firished at 12:45:12...
& Started 9°3/2009 at 12-45:19 AM. Freshed at 1:28:51
& Started 3722009 at 31740 AM. Finished at 3:21:28 AM N operations have besan found for the sslected session.
& Started 922009 at 3:30:36 AM. Finished at 3:41:04 AM
# Started 3722009 at 3:41:05 AM
& Started 922009 at 12-15:48 PM. Freshed at 12:20:26...
& Started 3722009 at 12-20-26 PM. Frished at 12:24:46..
# Started 922009 at 12:24:456 FM
# Sared 922009 at 12-06:15 PM. Freshed at 12:0747...
& Stared 922009 at 12-07:47 PM. Frished at 12:21:18...
¥ Stated 3722009 at 12-27:18 PM. Fnished at 12.30:15...
Started 97272009 at 1230015 PM. Finished at 12.31:33..
Sarted 37272009 at 12-31:33 PM. Finished at 12:41:47...
Started 9722009 at 12-44:44 PM. Finished at 12.58:38...
#- Started 3722009 at 1:08:03 FM

Cisk System Configuration Bafore Season Cisk: System Configuration After Session
Basic Hard Disk 0 (Viware, Viware Vidual 5 SC51 Disk Dey) - OF Basic Hard Disk 0 (Viware, Viware Virdual 5 SC51 Disk Dev) - OF
@ (C) @ (C)
NTF5 NTFS

Basic Hard Disk 1 (Viware, Viware Villual 5 SC51 Diske Dey) - OF Basic Hard Disk 1 (Viware, Viware Vidual 5 SC51 Diske Dev) - OF

P  P—
FREE FREE

Basic Hard Disk 2 (ViMware, Viware Vidual 5 SCS1 Diske Devy) - OF Basic Hard Disk 2 (ViMware, Viware Vidual 5 SCS51 Diske Dev) - OF

 [h— o —
FREE FREE

Typical Scenarios

This chapter lists a number of the most frequently used scenarios that may be accomplished with the program. You c
find here useful recommendations and descriptions of operations.

Backup Scenarios

Backing up a hard disk or partition to a network d  rive

To back up an entire hard disk or a separate partition and then place the resulted image to a network share pplease c
the following:

1. Click theSimple Backujtem of the Wizards menu.

There are other ways to start up this function, please consult inéerface Overview
chapter to know more on the subject.

2. On the Wizard's Welcome page, click the Next button.

3. OnthenextJ- 38> YIFNJ] GKS FLILINBLINRFGS 2LIA2y 2LI2aAGS |
the chosen task.
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Click the check box next to any hard disk drive or partition you want to back up

ANcne Type -
= Gl My Computer My Computer
& | [Z] Basic Hard Disk 0 (VMware, ViMware Vitual S SCS1 Disk Dev) Intemal Hard Disk Driv
= 7] 45 First Hard Disk Track First Track
] @ Master Bot Record MBR |
=[] {5] Basic Hard Disk 1 (VMware, VMware Vitual S SCS! Disk Dev) Intemal Hard Disk Driv|
| £ First Hard Disk Track Frrst Track
7] & Master Boct Record MER
7] & Local Disk (E) Prmary
] @ Local Disk (1) Primary
| (= Local Disk () Primary
Af@LocdDd‘(') Primary

= 71 [7] Basic Hard Disk 2 (VMware, VMware Vitual $ SCS! Disk Dev) intemal Hard Disk Driv ~
4 »

The size of objects to back up: 499.9 GB
Estimated archive size 7.2 GB

4. Map a network disk to place your backup image to:

- Call the Map Network Drive dialog by clicking the appropriate button;

Select a folder where archive should be placed and specify archive name. Archive name will be used as &
subfolder where backup data fles will be stored.

Archive location: |C-/arc_030909071551273/ e X ¥
Mo 67 Map Network Drive o) e |
Anetwork share - || ()

L E Map to dive letter - |2 [
7] Make permanent connection

%) Connect a5 user 0K Cancel

- Click the standard browse button [...] to browse for the required network share or manually enter a path to
it;
- Define a letter from the pullown list of available drive letters;

- Mark the checkbox to make this connection permanentéivise it will only be available for the current
Windows session;

- Click the Connect as user button at the foot of the dialog page to specify a user name and password to
access the selected network share if necessary.

5. Edit the archive name if necessary.

Please specify the archive name. Archive name will be used as a subfolder where backup data fies wil
be stored.

Archive detais
Archive name: arc_030509071001085
Estimated archive size: 44GB

Space avaisble on backup destnation: 38 GB
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Please take into account values of the parameters Estimated archiveaizeSpace
A available on backup destinationif the archive size exceeds the available space, another
network drive needs to be selected.

6. On the Backup Summary page review all parameters of the operation and modify them if necessary. Click the
Next buttonto start the backup process.

A This operation can also be accomplished wiihr recovery media

Recovery Scenarios

Correcting BCD (Boot Configuration Data)
To automatically corredVindowsBCD, please do the following:

1. Start up the computer from our WinREcoverymedia

To automatically boot fromthe recovery media please make sure the-tward BIOS is set
up to boot from CD/USB first.

2. LaunchBoot Corrector
3. On the Wizard's Welcome page, click the Next button.
4. Select 2 NNBOUG 0 2 2 io leLgheNzavdSixXiBE NI A found Windowmstallgions.

@ Windows installation to comect
View the list of all windows installations and comect boot parameters

@ Comrect the Master Boot Record (MBR)
View the kst of all Hard Disks and comect MBR executable code on some of them

@ Edit/View Sectors
View, edit, backup and restore sectors or a group of sectors on the hard disk or partition of your
choice

@ Comect boot parameters (boot ini, BCD)
Automatically comect boot ini and BCD on all hard disks in system

5. The wizard will ask you to confirm the operation. Apply the changes to complete.
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After completing the operation close the wizard, ahen reboot the computer.

Restoring a system partition from a network d  rive

[ SGQa aadzyS (GKIFG @2dzNJ O2YLIJzGSNI FILAfta G2 o622G 0SSOI dz
@2dzQ@S 320G | o010 1dzll 2F &2 drPBNKI NRI RRa| 28z SHNBYAKSHB I
track again.

To restore your system patrtition from a backup image located on a network drive, please do the following:

1. Start up the computer from our WIinPE recovery media.

To automatically boot from the recovery media please make sure thebmard BIOS is set
up to boot from CD/USB first.

2. Once you accept the agreement, you will see the Univepalication Launcher. Select the Restore Wizard.

3. On the Restore Wizard's Welcome page, click the Next button.

4. On the Browse for Archive page you need to specify the required backup image. So you should take the
following steps to do that:

1 SelectNetwork as a backup destination;

1 Map a network disk where your archives are placed:

- Call the Map Network Drive dialog by clicking the appropriate bytton
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